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Intended audience 
This Accessibility Compendium is designed for content creators who produce digital 
content for publication on Elsevier platforms.  

Quick reference guide 
I want to: I need to take the following steps: I can find more 

information about this 
on: 

Create or share 
an image for 
inclusion in 
digital content 

- Consider image accessibility 
- Check whether alt text is needed 

for this image 
- Write alt text where needed 
- Mark purely decorative images as 

such  
- Add alt text to the image or source 

file, as required by the platform. 

- Image accessibility, 
page 14 

- Alt text, page 4 

Share text for 
inclusion on a 
website 

- Provide accessible copy, including: 
o Use headings for document 

structure; 
o Write meaningful link text; 
o Use bulleted and numbered list 

functions 

- HTML accessibility, 
page 62 

Create a tagged 
PDF 

- Apply accessibility features to the 
source file 

- Review the accessible tags that 
Elsevier applies to its PDFs 

- Convert source file to an accessible 
PDF 

- Check the PDF using validation 
tools 

- Word accessibility, 
page 16 

- PDF accessibility, 
page 22 

- Appendix 1, Elsevier 
PDF tags, page 34 

Create an 
accessible 
video or audio 
file 

- Check whether captions, text 
transcript, and/or audio description 
are required, based on the video 
content 

- Choose the most appropriate 
workflow, tools and services for 
generating these 

- Supply the video and files for 
captions/ transcript/ audio 
description 

- Podcast and audio 
recordings 
accessibility, page 41 

- Video content 
accessibility, page 45 
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Key terms 
Assistive technology: Software or equipment that presents content in ways that makes 
it readable for persons with disabilities. Assistive technology includes screen-reading 
software such as NVDA, magnification tools, refreshable Braille displays, eye-tracking 
devices, mouth sticks, and assistive reading applications. 

PDF/UA: PDF/Universal Accessibility is the ISO standard 14289-1. It is a set of 
requirements for PDF documents that mean that all users can use them with an 
equitable level of effort. 

Screen reader software: An assistive technology software that helps people access 
digital content by audio and/or touch. Examples include NVDA, JAWS and VoiceOver. 
Screen readers allow a device to read content aloud or communicate it through a 
connected device such as a refreshable Braille display.  

Web Content Accessibility Guidelines: An international standard developed by the 
World Wide Web Consortium (W3C) that sets recommendations for web accessibility.  
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Alt text for images 

Introduction 
Alt text (alternative text) is a critical component of accessible digital content. It is 
descriptive text embedded within an image that conveys the essential information or 
function of that image. Alt text ensures that all readers, including users with visual 
impairments who use assistive technology such as screen reading software, can 
equitably access and understand visual content. Well-crafted alt text not only enhances 
accessibility but also improves the discoverability of images in search engines and 
browser searches. It is an essential element of meeting accessibility legislation, 
including the Americans with Disabilities Act (ADA) Title II update. 

This is a guide to alt text with links to key resources. 

When to use alt text 
Alt text is applicable to images that convey meaningful information, including: 

- Photographs, illustrations, and infographics that support or clarify the text. 

- Charts, graphs, diagrams, maps, and complex visuals that contain data or 
detailed information. 

- Functional images, such as icons or buttons, that serve a purpose. 

- Images that add context or are integral to understanding the content. 

Decorative images 
Alt text is not required for images that are purely decorative, such as background 
patterns or borders. How to mark an image as decorative will be outlined further in the 
On the Web section. 

Short and long alt text, and how they work together 
Although there is no strict limit to the length of alternative text for images, the ideal 
length is up to 200 characters, or about 25 to 30 words. This is recommended because 
screen reader users cannot pause narration while listening to alternative text. If the 
description is longer than 200 characters and they miss or misunderstand something, 
they must listen to the entire description again from the beginning. 

However, many scientific images are too complex to describe meaningfully in 200 
characters. In these cases, a longer description is required to give a literal translation of 
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the image, conveying all elements that are important to understand its intent and 
meaning. It may include multiple paragraphs. 

Long descriptions do not have a maximum character count and should aim to provide 
the right level of detail based on context rather than aim for a specific number of 
characters. Elsevier aims to keep long descriptions beneath 2,000 characters, to 
provide a meaningful description whilst keeping it concise and user-friendly. 

When to use short and/or long alt text 
Not all file formats can include both short and long alt text. Whether to include both 
descriptions, and how, will be determined by the image’s complexity (as described 
above), the file format, and the platform on which the image will appear. 

PDF, PowerPoint, Word, Excel, Visio: A single, plain text field for alt text. The 
description can include multiple paragraphs, but the files do not allow for other 
formatting such as lists. For these formats, the guidance is: 

- If the alt text consists of only a short description, include the short alt text. 

- If the alt text includes both long and short descriptions, include the long alt text. 

EPUB: Both short alt text and long description. 

On the web: Both short alt text and long description. For more complex graphics that 
require a longer description, it is best to provide the long description in a disclosure 
below the image or link to a separate page with the full text. This approach benefits all 
users, not just those using screen readers. 

How does alt text differ to a figure caption in book and journal content? 
A figure caption puts the image in the context of the rest of the chapter or text. It 
appears on the page or screen. While the caption may briefly describe the image and/or 
its purpose it is generally not as visually rich as alt text. 

Alt text provides a more detailed, literal description of what is in an image. It does not 
appear on the page of a PDF. Alt text is read aloud when assistive technology, such as 
screen reader software, encounters the image, communicating the visual in text form.  

Together the figure caption, alt text, and the body text that refers to the image give a 
complete description of the visual. 
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Principles for writing alt text 

Context is key 
- The same image may be described differently depending on its context. 

- Review the surrounding content to see how the image has already been 
described. 

- Determine which image details are important in the context of the content and 
the intention of the image.Where the image is fully visually described in close 
proximity to the image, alt text may not be needed and the image could be 
considered as decorative. Note that for Elsevier content this rarely applies to 
books and journals, but is more common for web platforms and products where 
images a highly described on the screen. 

Clear and logical structure 
- Imagine that you are visually describing the image to somebody over the phone 

who needs to understand it. 

- Start with a broad overview of what the image depicts. 

- Add specific details to describe the key elements. 

- Elsevier’s journal alt text includes ‘Alt text begins’ at the start of the description 
and ‘Alt text provided by Elsevier’ at the end, to separate the image description 
from the caption and body text. You may wish to follow the same approach; see 
the Examples of alt text section for sample descriptions. 

- Write in digestible sections. 

- Describe complex or multi-part images in a logical order: left to right, top to 
bottom, or in the order labels appear and keep that order consistent for images 
following the same visual structure throughout the document. For multi-part 
images, describe each part clearly, indicating their relationship. 

- Avoid using positional or sensory language to describe images. For example, 
instead of saying “On the left is the outline of a cat and on the right is the outline 
of a dog,” use descriptions like “Part A is the outline of a cat and Part B is the 
outline of a dog.” This approach is more helpful for non-sighted users, who are 
the primary audience for alternative text, because positional references do not 
provide meaningful context for them. 

- For diagrams and charts, describe the type of chart, axes, labels, and key data 
trends. 

- For images that contain text, transcribe the text in full. 
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Tone and language 
- Write in language suitable for your audience.  

- Match the tone of nearby content. 

- Use appropriate language and dialect for the content, such as UK or US English. 

- Describe what is visible, without adding interpretation or subjectivity. 

- Spell out acronyms in full, adding a space between letters in abbreviations that 
could be read out as a word, such as M A for Master’s, which may be read as ‘Ma’. 

- Use inclusive language: avoiding terms, phrases or expressions that may 
exclude, marginalize, or stereotype individuals based on characteristics such as 
race, gender, disability, or age. Avoid gendered terms unless relevant, and 
describe people with respectful, person-first language. 

- Markup such as LaTeX and MathML cannot be conveyed to readers in alt text. 
Instead, write out scientific notification, such as ‘H sub 3 PW sub 12 O sub 40’ for 
H3PW12O40. 

- Check spelling, grammar and punctuation. 

- End alt text with a period so it is clear that the reader has reached the end. 

- The alt text matches the language of the text in the image; for example, if the 
image text is in French the alt text matches. 

- For web-based content, if you add alt text in a language different from the main 
language of the page, you need to include a ′lang′ attribute with the correct 
language code to inform assistive technologies of the language used in the 
description. For images that may be used in various contexts, such as those in 
an image library, it is best to include a ′lang′ attribute by default. If alternative text 
is stored separately from the image, be sure to track the language of the alt text 
so it can be accurately communicated to assistive technology users. 

Avoid unnecessary details 
- Screen reader software announces an image, so it is not necessary to start with 

phrases such as “image of” or “picture of”. But be specific when referring to a 
type of image, such as “A bar chart” or “A CT scan”. 

- Avoid repeating the caption or surrounding text. 

- For short alt text, do not include lists or bold and italic for emphasis, because 
these will not be picked up by screen readers. 
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Review the description 
- After writing the alt text, take a step back and consider whether it reflects the key 

information and the intention of the image.  
- Edit for accuracy, for example checking dosage information is accurate, or that 

labels are correctly spelled out. 

Examples of alt text 
The examples below display two different approaches to alt text: (1) separate short and 
long alt text descriptions, and (2) a combined alt text description for file formats that 
have a single alt text field (as described in the section When to use short and/or long alt 
text. 

Simple radiograph 

 

Short alt text: Alt text begins. Radiograph of the bile and pancreatic ducts and 
surrounding structures. Alt text provided by Elsevier. 

Long description: Alt text begins. Contrast medium makes the common hepatic duct, 
pancreatic duct, cystic stump, and common bile duct appear almost opaque and white 
in the radiograph. An opaque white outline of the endoscope is visible. Alt text provided 
by Elsevier. 

Combined alt text for single-field formats: Alt text begins. Radiograph of the bile and 
pancreatic ducts and surrounding structures. Contrast medium makes the common 
hepatic duct, pancreatic duct, cystic stump, and common bile duct appear almost 
opaque and white. An opaque white outline of the endoscope is visible. Alt text provided 
by Elsevier. 
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Simple multi-part image 

 

Short alt text: Alt text begins. Two images positioned side-by-side show a labelled 
illustration of an open mouth (Part A) and a labelled cutaway of the human head 
focused on the pharynx (Part B). Alt text provided by Elsevier. 

Long description: Alt text begins. Part A is a drawing of an open mouth with structures 
listed from top: lip, hard palate, incisors, cuspid, bicuspids, molars, soft palate, uvula, 
palatine tonsil, tongue. Part B is a cutaway drawing of the pharynx with structures listed 
from the top: nasopharynx, oropharynx, hypopharynx. Alt text provided by Elsevier. 

Combined alt text for single-field formats: Alt text begins. Two-part image. Part A is a 
drawing of an open mouth with labels to teeth (incisors, cuspid, bicuspids and molars), 
lip, hard and soft palate, uvula, palatine tonsil, and tongue. Part B is a cutaway drawing 
of the human head focused on the pharynx, with labels listed from the top to the 
nasopharynx, oropharynx, and hypopharynx. Alt text provided by Elsevier. 

Complex chemical diagram 
Note on chemical notation and described math: It is possible to format the alt text in 
web-based content but not in PDF or Microsoft Office products. The examples below do 
not include superscript or subscript notation, but writers creating alt text for the web 
should use this formatting, which will be picked up by screen readers. Superscript and 
subscript can also be provided in platform-specific notation; for example from Word or 
embedded using LaTeX notation. 
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Short alt text: Alt text begins. A chemical diagram showing the molecular structures of 
2 bimetallic ruthenium photocatalyst complexes (3 and 4) and the proposed 
mechanism for light-driven sulfide oxygenation using water as oxygen source. Alt text 
provided by Elsevier. 

Long description: This figure illustrates bimetallic ruthenium dyads for photocatalytic 
sulfide oxygenation, where light drives oxygen atom transfer from water to sulfide 
substrates via a proton-coupled electron transfer (PCET) mechanism. It contains 3 
components: molecular structure (top), catalytic cycle (bottom left), and substrate 
transformation (bottom right). 

Molecular structure. A dinuclear ruthenium complex with Ru sub phot (orange, light-
absorbing) and Ru sub cat (green, catalytic) centres connected by a bridging ligand 
(tetrapyridophenazine). A sun symbol indicates light absorption; a red curved arrow 
illustrates electron transfer from Ru sub cat to Ru sub phot. 2 variants are shown: 
complex 3 (X = H sub 2 O, n = 4) and complex 4 (X = Cl, n = 3). 

Catalytic cycle. Stepwise light-driven oxidation: Ru-Ru sup II (OH sub 2) yields Ru-Ru 
sup III (OH) yields Ru-Ru sup IV (O). A cobalt-based electron acceptor cycle (Co sup III / 
Co sup II, H sup plus) regenerates the catalyst. Water provides the oxygen atom. 

Substrate transformation. A dibrominated thioanisole (sulfide) is converted to its 
corresponding sulfoxide, with oxygen added to the sulfur atom. 

Central finding: Complex 3 outperforms complex 4 (turnover number 201 versus 81), 
attributed to the H sub 2 O ligand. Alt text provided by Elsevier. 
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A note on combined alt text for this image: The description features the short alt text 
followed by the long description text. For brevity it is not included in full here. 

Complex multi-part image 

 

Short alt text: Alt text begins. A 10-panel figure compares 2 isomeric photosensitizers 
for photodynamic therapy: DTPA-2,5-BT-P forms nanoshuttles with enhanced tumour 
penetration, while DTPA-5,2-BT-P forms less effective nanospheres. Alt text provided by 
Elsevier. 

Long description: Alt text begins. This figure compares 2 structurally isomeric 
photosensitizers for photodynamic therapy (PDT). Despite identical chemical 
compositions, they self-assemble into different nanostructures with dramatically 
different therapeutic efficacy. The 10 panels are presented as follows. 

Panel A: Conceptual comparison. Left (nanoshuttle): DTPA-2,5-BT-P forms elongated 
shuttle-shaped nanoparticles that enable enhanced reactive oxygen species (ROS) 
generation, fast endocytosis, and deep tumour penetration. Live cells (blue) become 
dead cells (orange) upon treatment. Right (nanosphere): DTPA-5,2-BT-P forms spherical 
nanoparticles with limited ROS, normal endocytosis, and incomplete tumour 
penetration. 

Central panel: Molecular structures. Both isomers share triphenylamine (TPA) donor 
units and benzothiadiazole-thiophene acceptor cores with PF sub 6 counterions. DTPA-
2,5-BT-P forms nanoshuttles; DTPA-5,2-BT-P forms nanospheres upon ultrasound 
processing with DSPE-PEG. 
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Panels B–E: Optical properties. Panel B: UV-visible absorption spectra (300–800 
nanometres). Panel C: Photoluminescence spectra showing emission peaks. Panel D: 
Aggregation-induced emission plot showing intensity ratio (I/I sub 0) versus water 
fraction (0–100 per cent). Inset photographs show emission at 0 and 90 per cent water. 
Panel E: Emission spectra in aggregated state.  

Panels F–H: Computational chemistry. Panel F: Optimised molecular geometries 
showing HOMO and LUMO orbital distributions. Energy gaps: E sub g = 2.43 eV (DTPA-
2,5-BT-P) and 1.99 eV (DTPA-5,2-BT-P). Panels G–H: Electrostatic potential surfaces 
showing charge distribution. Delta ESP = 103.68 kcal/mol (DTPA-2,5-BT-P) and 100.55 
kcal/mol (DTPA-5,2-BT-P). 

Panels I–J: Energy level diagrams. Singlet (S sub 1, S sub 2) and triplet (T sub 1, T sub 2, T 
sub 3) state energies with spin-orbit coupling constants (xi). Small energy gaps and non-
zero xi values indicate efficient intersystem crossing for ROS generation. Alt text 
provided by Elsevier. 

A note on combined alt text for this image: The description features the short alt text 
followed by the long description text. For brevity it is not included in full here. 

Adding alt text to different image formats 

Microsoft Office (Word, PowerPoint, Excel, Visio, OneNote and Outlook) 
Informative images: Right-click the image and select ‘Edit Alt Text’ to open the alt text 
field. Place the alt text in the text field. 

Decorative images: Right-click the image and select ‘Edit Alt Text’. In the alt text field 
that opens check the box ‘Make decorative’. 

Adobe InDesign 
Informative images: After placing an image, select Object > Object Export Options. In 
the Alt Text menu, select Custom. Enter the alt text in the text field. 

Decorative images, also known as ‘artifacts’: Select the image. Go to Object Export 
Options > Tagged PDF. In the dropdown menu select Artifact.   

InDesign’s automatically generated alt text: Since January 2026, Adobe InDesign has 
the functionality to generate English-language alt text for the images placed in 
documents. This feature is automatically turned on for premium users with unlimited 
credits. As with all AI-generated image descriptions, consider the accuracy, relevance 
and completeness of the alt text alongside intellectual property and other editorial 
factors. We recommend human review of any automated alt text prior to it going live. 
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To turn off automatic alt text generation, go to: File > Preferences > Generative 
AI (Windows) or InDesign > Preferences > Generative AI (macOS). 

Adobe Acrobat Pro 
It is possible to add alt text directly to a PDF using Adobe Acrobat Pro (this feature is not 
available in Adobe Reader). However, be aware that the alt text will be lost if the PDF is 
re-generated at any point in the workflow. Add alt text to the source document to save 
repeated data entry. 

For more information on how to add alt text to the PDF, see W3C – Applying text 
alternatives to images with the Alt entry in PDF documents. 

On the Web 
Informative images: In HTML, add alternative text to an image element using the alt 
attribute. 

Example: <img alt="cat"> 

For SVG images, first ensure the parent element has role="img". Then provide alternative 
text using a <title> child element and link the SVG container to the title with the aria-
labelledby attribute. 

Example: 
<svg role="img" aria-labelledby="svgtitle1"> 

<title id="svgtitle1">cat</title>...</svg> 

Decorative images: Set the image with a null (empty) alt text attribute, i.e. alt="" or just 
the alt attribute by itself without any value. 

Further resources 
W3C Images Tutorial. 

DIAGRAM Center Image Description Guidelines. 

The DAISY Consortium webinar series. 

WebAIM Alternative Text. 

textBOX Image Description Gallery. 

Alternative Text and Long Description – Best Practices.  

https://www.w3.org/WAI/WCAG21/Techniques/pdf/PDF1
https://www.w3.org/WAI/WCAG21/Techniques/pdf/PDF1
https://www.w3.org/WAI/tutorials/images/
http://diagramcenter.org/table-of-contents-2.html
https://daisy.org/webinar-series/
https://webaim.org/techniques/alttext/
https://www.textboxdigital.com/textgallery
https://a11y.canada.ca/en/alternative-text-and-long-description-best-practices/index.html
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Visual image accessibility 
Accessible images require more than alt text. The guidance below outlines best practice 
for making static images visually accessible and provides links to key resources. 

General design principles 
Refer to and explain visual elements in the main text and include captions to place the 
image in the context of the content. 

Keep images close to their related text.  

If text must be placed over an image, ensure sufficient color contrast; for example, by 
inserting a semi-transparent overlay between the text and the image. 

Avoid including images of text; assistive technologies cannot read the content of an 
image. Where unavoidable, ensure that the text also appears in either the content or in 
full as the alt text. 

Use simple design with an uncluttered layout. 

Text size of 12pt minimum, in a clear, sans-serif font such as Arial, Aptos or Verdana. 

Use of color 
Text color contrast: Aim for a minimum of 4.5 to 1 text to background contrast ratio to 
meet the WCAG 1.4.3 Contrast criterion, such as place name labels on a country map. 

Non-text color contrast: Ensure a minimum 3 to 1 contrast ratio between adjacent 
elements, such as including boundary lines between differently colored regions on a 
country map. See WCAG 1.4.11 Non-text Contrast. 

Use of color: Do not use color alone to distinguish features on a map. Consider the use 
of shades, lines, patterns (sparingly), and labels. 

Key resources:  

- TPGi Colour Contrast Analyser 
- WebAim Contrast Checker 

Charts, figures and diagrams 
Key principles for chart, figure and diagram accessibility include: 

- A clear and descriptive chart title; 
- Clear, spaced chart axes titles and labels; 

https://aaardvarkaccessibility.com/wcag-plain-english/1-4-3-contrast-minimum/
https://www.w3.org/WAI/WCAG22/Understanding/non-text-contrast
https://www.tpgi.com/color-contrast-checker/
https://webaim.org/resources/contrastchecker/
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- Data labels; 
- Alt text: short alt text and a long description conveying the important information 

in the image; 
- Minimum text contrast of 4.5 to 1 against its background; 
- Minimum non-text contrast of 3 to 1 for adjacent visual elements, such as slices 

in a pie chart or lines in a line chart; 
- Combining patterns and textures with colors that show distinctly when viewed in 

color and in monochrome 

Microsoft Excel’s online template library contains templates that are set up to be 
accessible. You can access these when you first open Excel, by typing ‘accessible 
templates’ into the search bar. See Microsoft Office – Start with an Accessible Excel 
Template and Create More Accessible Charts in Excel. 

Maps 
Key principles for map accessibility include: 

- Inclusion of a legend where appropriate; 
- Labels: clear and not overlapping; 
- Minimum text color contrast, such as for place name labels on a country map; 
- Non-text color contrast, such as including boundary lines between differently 

colored regions on a country map.  
- Ensure use of shades, lines, patterns (sparingly), and labels to avoid using color 

as the only means of conveying information. 

Alt text 
There is a separate section in this compendium on alt text: see Alt text for images.  

Interactive maps 
Interactive maps are subject to WCAG 2.1 AA criteria, including: 

1.4.11 Non-text Contrast. 

1.4.13 Content on Hover or Focus. 

2.1.1 Keyboard Accessible. 

2.1.2 No Keyboard Trap. 

2.1.4 Character Key Shortcuts. 

2.4.3 Focus Order. 

2.4.7 Focus Visible.  

https://support.microsoft.com/en-us/office/video-start-with-an-accessible-excel-template-918db751-1585-41c5-9ddf-5d7a0915afaf?ui=en-US&rs=en-US&ad=US
https://support.microsoft.com/en-us/office/video-start-with-an-accessible-excel-template-918db751-1585-41c5-9ddf-5d7a0915afaf?ui=en-US&rs=en-US&ad=US
https://support.microsoft.com/en-us/office/video-create-more-accessible-charts-in-excel-19e81ce7-88af-4a3f-a4ef-a26c344527b3?ui=en-US&rs=en-US&ad=US
https://www.w3.org/TR/WCAG21/
https://www.w3.org/TR/WCAG21/#non-text-contrast
https://www.w3.org/TR/WCAG21/#content-on-hover-or-focus
https://www.w3.org/TR/WCAG21/#keyboard-accessible
https://www.w3.org/TR/WCAG21/#no-keyboard-trap
https://www.w3.org/TR/WCAG21/#character-key-shortcuts
https://www.w3.org/TR/WCAG21/#focus-order
https://www.w3.org/TR/WCAG21/#focus-visible
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Microsoft Word accessibility 
This is a guide to Word document accessibility with links to key resources. An accessible 
Word document makes it easier to create an accessible PDF that meets legal 
accessibility standards. 

General principles of Word accessibility 

The Microsoft Accessibility Checker 
The built-in Microsoft Accessibility Checker quickly checks a Word document and 
presents a list of actions to make the document accessible. It is an important and easy 
to use accessibility tool for Microsoft Office documents. 

Find the Accessibility Checker in the Review tab and select ‘Check Accessibility’. 

In the Accessibility Checker results box that appears, you can also tick the box to keep 
the checker running while you work on a document, which places an accessibility 
status in the footer of the document. 

Run the checker tool before completing a document to verify many of the points below, 
especially focusing on the Warnings and Errors. 

Key resource: Microsoft – Improve accessibility with the Accessibility Checker. 

Choosing a template 
If you are looking to create a new template, Microsoft has a range of accessible 
templates. Select New from the File menu and search in the Online Templates and 
Themes field for ‘accessible templates’.  

Key resource: Microsoft – Get accessible templates for Office.  

Font choice and font size 
A minimum of 12pt for the base font size for a positive reading experience. 

Clear fonts for readability, such as Arial, Aptos or Verdana. 

Size 14pt or above when creating large-print content. 

Filename and properties 
Word documents contain file property metadata which describes the document and 
increases its online discoverability and search engine optimisation. The metadata 
entered in Word is also taken through to a PDF during conversion. 

https://support.microsoft.com/en-us/office/improve-accessibility-with-the-accessibility-checker-a16f6de0-2f39-4a2b-8bd8-5ad801426c7f#PickTab=Windows&picktab=windows
https://support.microsoft.com/en-us/office/get-accessible-templates-for-office-ca086caa-2bd2-4ac8-8c12-4cd495bd4d76#:%7E:text=Templates%20that%20help%20you%20make%20your%20content%20accessible,get%20to%20them%20straight%20from%20your%20Office%20application.
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Find the document properties under ‘Info’ in the File tab.  

Save the document in the format ‘.docx’, to enable accessibility features such as the 
accessibility checker and testing. 

Key resources:  

- Microsoft – View or change the properties for an Office file. 
- WCAG 2.4.2 Page titled. 

Specify language 
Assistive technologies use the document language to correctly present and pronounce 
the content. A document may contain one or more languages and read-aloud 
technologies will switch between multiple languages as they encounter them in a 
document. 

Setting the primary language 
The default language for Word files is located at File > Options > Language.  

Setting a secondary language 
A secondary language can be assigned at Review > Language > Set Proofing Language. 

Key resources:  

- Microsoft – Change the language for selected text. 
- WCAG 3.1.1 Language of page. 
- WCAG 3.1.2 Language of parts. 

Use of color 

Color contrast 
It is important to have sufficient text contrast against the background; for example, 
black text on white or white text on black.  

The built-in Microsoft Accessibility Checker will identify insufficient color contrast, and 
the key resource tools below can check the contrast ratio between colors. 

WCAG 1.4.3 Contrast (Minimum): 

• Large-scale text (at least 18pt or 14pt and bold) has a contrast ratio of 3 to 1. 
• Regular text has a contrast ratio of 4.5 to 1. 

https://support.microsoft.com/en-us/office/view-or-change-the-properties-for-an-office-file-21d604c2-481e-4379-8e54-1dd4622c6b75
https://www.w3.org/WAI/WCAG21/Understanding/page-titled
https://support.microsoft.com/en-us/office/set-up-or-change-the-languages-used-to-check-spelling-and-grammar-64bd812f-a301-478b-883a-32ee2223d42d
https://www.w3.org/WAI/WCAG21/Understanding/language-of-page
https://www.w3.org/WAI/WCAG21/Understanding/language-of-parts
https://w3.org/TR/WCAG21#contrast-minimum
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Key resources:  

- TPGi Colour Contrast Analyser 
- WebAim Contrast Checker 

Avoid using color or formatting alone to convey meaning 
Using formatting or color as the only way to convey meaning or emphasis may mean 
that users miss out on important information. This includes use of color; formatting 
such as bold, italic, or underline; or the style or size of font. 

Options include using textures and different types of lines like dashes and dots in graphs, 
or different shades of the same color, to clearly differentiate between elements.  

Key resource: W3C – Use of Color. 

Headings and document structure 
Readers using assistive technology such as screen readers use the heading structure 
within a document to navigate between sections. The order of the heading structure 
determines the outline for these technologies. 

The built-in Word heading styles give the document structure. The title is considered 
heading 1; further headings are assigned level 2, level 3, and so on. See, for example, 
How Heading Structure Works. 

Order content into a logical structure, using clear and descriptive headings and 
subheadings.  

Heading levels follow a sequential order, ideally without skipping levels; for example, a 
level 3 heading appears only after a level 2 heading. 

The Navigation Pane in the View tab visualizes the document’s hierarchy of headings. 
This outline view can be useful to check the sequential order, and it will also be 
navigable by readers to quickly move between sections. 

Key resources:  

- Microsoft – Add a heading in a Word document. 
- Microsoft – Customise or create new styles. 
- WCAG 1.3.1 Info and Relationships. 

Spacing and alignment 
Word styles can be modified to: 

- Add space above and below, such as headings and paragraphs; 

https://www.tpgi.com/color-contrast-checker/
https://webaim.org/resources/contrastchecker/
https://www.w3.org/WAI/WCAG21/Understanding/use-of-color.html
https://www.section508.gov/blog/accessibility-bytes/document-headings/
https://support.microsoft.com/en-us/office/add-a-heading-in-a-word-document-3eb8b917-56dc-4a17-891a-a026b2c790f2
https://support.microsoft.com/en-us/office/add-a-heading-in-a-word-document-3eb8b917-56dc-4a17-891a-a026b2c790f2
https://support.microsoft.com/en-us/office/customize-or-create-new-styles-d38d6e47-f6fc-48eb-a607-1eb120dec563
https://www.w3.org/WAI/WCAG21/Understanding/info-and-relationships
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- Use page breaks to start text on a new page; 
- Set line spacing. 

Bulleted and numbered lists 
Using the built-in Word functions to create bulleted and numbered lists makes them 
recognisable and navigable for assistive technologies. 

Key resources:  

- Microsoft – Create a bulleted or numbered list 
- Microsoft – Change line spacing between bullets in a list in Word 

Alt text for visual content 
Alt text provides a textual equivalent for an image, enabling people using screen readers 
to receive the important information in the visuals. Word documents can include a 
combination of image types: 

- Informative: Images that convey information for the user contain alt text.  
- Decorative: Purely decorative images, such as lines or colored backgrounds, are 

marked as decorative and do not contain alt text.  
- Functional: Images that function as a link or button contain alt text that 

describes their purpose. 
 
Add a contextually relevant description in the alt text field. 

There is a separate section in this compendium on alt text: see Alt text for images.  

Key resources:  

- Microsoft – Add alt text to visuals 
- W3C Images Tutorial 
- DIAGRAM Center Image Description Guidelines 
- WCAG 1.1.1 Non-text Content. 

Informative links 
Display meaningful link text that clearly communicates what the user will find when 
they select it. For example, Elsevier Accessibility homepage. 

Use descriptive text to label links. Screen reader users have the ability to select from a 
list of all the links in a document, and unique, clear links are quickly identifiable. 

A note on printed URLs: There may be times when you would want to provide the full 
address of a web resource, for example when a document is intended to be printed. Be 

https://support.microsoft.com/en-us/office/create-a-bulleted-or-numbered-list-9ff81241-58a8-4d88-8d8c-acab3006a23e
https://support.microsoft.com/en-us/office/create-a-bulleted-or-numbered-list-9ff81241-58a8-4d88-8d8c-acab3006a23e
https://support.microsoft.com/en-gb/office/change-line-spacing-between-bullets-in-a-list-in-word-2c83b66f-3ac3-45cf-976a-ba3639ae4f06
https://support.microsoft.com/en-us/office/make-your-powerpoint-presentations-accessible-to-people-with-disabilities-6f7772b2-2f33-4bd2-8ca7-dae3b2b3ef25#bkmk_winalttext
https://www.w3.org/WAI/tutorials/images/
http://diagramcenter.org/table-of-contents-2.html
https://www.w3.org/WAI/WCAG21/Understanding/non-text-content
https://www.elsevier.com/about/accessibility
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aware that a URL may be difficult to understand, particularly if it is lengthy and/or being 
read by screen reading software. 

Key resource:  

- Microsoft – Add accessible hyperlink text and Screentips. 
- WCAG 2.4.4 Link Purpose (In Context). 

Footnotes and endnotes 
Automatic footnotes and endnotes contain circular links between the note marker and 
the note text.  

Find the footnote and endnote function in the References tab.  

The style of the note markers can be modified in the footnote and endnote pop-out 
menu and applied across the whole document. It is possible in this same menu to 
convert all footnotes to endnotes, and vice versa. 

Tables 
Principles for accessible tables include: 

- Use the built-in Insert Table function; 
- Use simple structures, avoiding split, merged or nested cells where possible; 
- Avoid empty cells. Add a dash, a 0, or “N/A” as appropriate to indicate that the 

cell is intentionally empty;  
- Assign row and/or column headers to header rows; 
- Repeat headers at the top of the page for multi-page tables; 
- Check the reading order is as intended. Tables in Word are read left to right 

across a row, before moving on to the next row. You can check the order and 
identify errors by placing the cursor in the top-left cell and using the Tab key to 
move through the table. 

Key resource: Microsoft – Create accessible tables in Word. 

Text boxes 
The built-in Accessibility Checker will identify text boxes that are not placed inline. 

Key resources: Section 508 – Create Accessible Textboxes. 

Page numbers 
Page numbers are useful for all readers.  

Key resource: Microsoft – Insert page numbers. 

https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d#bkmk_links_and_screentips_win
https://www.w3.org/WAI/WCAG21/Understanding/link-purpose-in-context
https://support.microsoft.com/en-us/office/video-create-accessible-tables-in-word-cb464015-59dc-46a0-ac01-6217c62210e5
https://www.section508.gov/training/documents/aed-cop-docx10/
https://support.microsoft.com/en-us/office/insert-page-numbers-9f366518-0500-4b45-903d-987d3827c007
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Videos 
There is a separate section in this compendium on videos: see Video content 
accessibility. 

Table of Contents 
Tables of Contents can be generated using the Heading styles assigned to the 
document headings. 

Key resources: Microsoft – Insert a table of contents. 

Further resources 
Make Your Word Documents Accessible to People with Disabilities. 

Use MS Word to create an accessible document. 

  

https://www.w3.org/WAI/WCAG21/Understanding/audio-description-prerecorded
https://www.w3.org/WAI/WCAG21/Understanding/audio-description-prerecorded
https://support.microsoft.com/en-us/office/insert-a-table-of-contents-882e8564-0edb-435e-84b5-1d8552ccf0c0
https://www.bing.com/ck/a?!&&p=682609f40358b825e650982b9e76d4c25f325ae23171676256b9f27762e26733JmltdHM9MTc2MjczMjgwMA&ptn=3&ver=2&hsh=4&fclid=072feb73-751a-6583-14cd-fd4a74a1648f&psq=accessible+word+documents&u=a1aHR0cHM6Ly9zdXBwb3J0Lm1pY3Jvc29mdC5jb20vZW4tdXMvb2ZmaWNlL21ha2UteW91ci13b3JkLWRvY3VtZW50cy1hY2Nlc3NpYmxlLXRvLXBlb3BsZS13aXRoLWRpc2FiaWxpdGllcy1kOWJmMzY4My04N2FjLTQ3ZWEtYjkxYS03OGRjYWNiM2M2NmQ
https://www.gov.uk/government/publications/how-to-produce-accessible-documents-for-the-department-for-transport/use-ms-word-to-create-an-accessible-document
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Accessible PDFs 
The following provides guidance on PDF accessibility and links to key resources. 

PDFs and the Web Content Accessibility Guidelines (WCAG) 
A PDF document uploaded to a website becomes web content, and therefore the 
WCAG requirements apply to meet accessibility legislation. The Americans with 
Disabilities Act (ADA) Title II update in April 2026 emphasises conformance to the 
WCAG 2.1 AA standard, which includes provisions that allow people with disabilities to 
access content and websites with the same level of effort as everybody else.  

PDF/UA (Universal Accessibility) is an international PDF accessibility standard that 
includes many of the WCAG criteria.  

Start with an accessible source document 
The optimal way to create an accessible PDF is to make the source document 
accessible; for example, Word or InDesign. Many features from the source (such as alt 
text for images) carry across to the PDF on conversion. 

Examples of accessibility features that can be added to the source document include:  

- Heading structure; 
- Alternative (alt) text for images; 
- Bookmarks; 
- Accessible tables; 
- Document title; 
- Document language; 
- Lists. 

This compendium also includes a section on Microsoft Word accessibility. 

If the source document is not available, it is still possible to make a PDF accessible, but 
it is a more manual process with the aid of a remediation tool.  

Key resources:  

- Adobe – PDF Accessibility Review. 
- Acrobat Pro – Create and Verify PDF Accessibility. 
- Creating Accessible PDF Files Using Adobe InDesign, by Chad Chelius. 
- W3C – PDF Techniques for WCAG 2.2. 
- PDF/UA. 

https://www.w3.org/TR/WCAG21/
https://www.adobe.com/accessibility/pdf/pdf-accessibility-overview.html
https://helpx.adobe.com/uk/acrobat/using/create-verify-pdf-accessibility.html
https://www.youtube.com/watch?v=j5CND3bbuSI
https://www.w3.org/WAI/WCAG22/Techniques/#pdf
https://pdfa.org/resource/iso-14289-pdfua/
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PDF tagging 
Tags provide the structure for a PDF document. Users of assistive technology such as 
screen reader software use the tags to navigate through the headings and content on a 
page. Assistive technology will skip over untagged content. Therefore, ensure all 
content in a document that is intended to be read has a corresponding tag.  

Common tags include the following: 

Tag Name Use 
<Document> Document Overall container for the tags in a PDF 
<P> Paragraph Body text 
<H1> Heading 1 Level 1 heading 
<H2> Heading 2 Level 2 heading 
<H3> Heading 3 Level 3 heading 
<H4>–<H6> Headings 4–6 Level 4–6 headings 
<L> List Overall container for a list 
<LI> List Item Individual numbered or bullet list item  
<Lbl> Label Numbered or bullet point list character 
<LBody> Label body The text content of a List Item 
<TOC> Table of Contents Overall container for a Table of Contents 
<TOCI> Table of Contents Item Individual Table of Contents text item, contains 

both the text and the live link 
<Figure> Figure Image or graphic 
<Caption> Caption Figure or table caption 
<Formula> Formula Mathematical formula 
<Quote> Quote Quoted text within a paragraph 
<Blockquote> Quote Long quotations that appear as their own 

paragraph 
<Table> Table Overall container for a Table 
<TR> Table Row Individual table row content 
<TH> Table Header Table header cell: row, column, or both 
<TD> Table Data Individual table cell content 
<Link> Hyperlink Link, e.g. a URL 
<Reference> Reference References or citations and internal document 

references, e.g. endnote, TOC 
<OBJR> Object Reference Active element of the Reference or a Link, which 

sits within either of these tags 
<Span> Span Separator for text formatted differently, e.g. 

second language, italic, bold 
<Form> Form Interactive form 
<Artifact> Artifact Decorative elements such as borders and 

background images that should be ignored by 
assistive technology software  

 

Appendix 1 contains a list of PDF tags that Elsevier applies to its content. Link to 
Appendix 1: Elsevier PDF tagging. 
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Checking and remediating a PDF for accessibility 
There are several software applications that can check PDFs for accessibility and 
remediate them. Common tools include: 

Adobe Acrobat Pro: Can be used to check PDF accessibility and remediate the 
identified accessibility issues. A mainly automated tool that requires some manual 
checks. Note that Adobe Reader (the free package) does not have this functionality. 

PDF Accessibility Checker (PAC): A tool to check PDF accessibility against the latest 
WCAG and PDF/UA (Universal Accessibility) standards. PAC is not a remediation tool. 

AxesPDF: Can be used to check PDF accessibility and remediate the identified 
accessibility errors. A mostly automated tool that requires some manual checks. 

CommonLook PDF: Can be used to check PDF accessibility and remediate the 
identified accessibility issues. A mostly automated tool that requires some manual 
checks. 

This guide details one possible checking, remediation and validation method, using 
(1) the Adobe Acrobat Pro Accessibility Checker tool to check and remediate a PDF, and 
(2) the PAC tool to validate against the WCAG and PDF/UA standards. See the sections 
below on Adobe Acrobat Pro Accessibility Checker criteria and resources and PDF 
Accessibility Checker (PAC). 

PDF Accessibility Checker (PAC) 
The PAC tool can be used to validate a PDF against WCAG and PDF/UA. Uploading a 
PDF to this tool after running it through a remediation tool can validate conformance to 
these standards. 

It is possible to generate a conformance report per PDF for both standards. 
Suppliers/vendors can use this tool to confirm that these standards have been met. 

Key resource: PAC – PDF Accessibility Checker. 

Testing using a screen reader 
Checking a PDF using a screen reader is a useful way to identify any issues that could 
be missed by automated tools but which may affect the reading experience of users of 
assistive technology. Listening to your PDFs can pick up mistakes that are more tricky to 
notice visually, such as reading order, form navigation, and the quality of alt text. 

Including a spot-checking process in your workflow can identify issues affecting 
individual or lists of documents. 

https://pac.pdf-accessibility.org/en
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Ideally a document will be checked by more than one screen reader software, such as 
NVDA (for Windows users) and VoiceOver (for Apple users).  

To check a PDF: 

1. Open the PDF document; 
2. Launch the screen reader software; 
3. Navigate through the document with the keyboard, using the commands for the 

software. 

Key resources:  

- WebAIM – Testing with Screen Readers: Questions and Answers. 
- WebAIM – Using NVDA to Evaluate Web Accessibility. 
- Apple – VoiceOver User Guide. 
- WebAIM – VoiceOver. 

Adobe Acrobat Pro Accessibility Checker criteria and resources 
This section explains how to use the Adobe Acrobat Accessibility Checker and outlines 
the criteria it uses to evaluate a PDF document. 

Running the Accessibility Checker 
The ‘Prepare for accessibility’ tool in Adobe Acrobat includes the action ‘Check for 
accessibility’. Selecting this action runs the Accessibility Checker tool (hereon ‘the 
tool’). 

Running the tool generates a report for your PDF with actions to fix it. 

The tool assesses a PDF against 32 criteria. Depending on the content, not all criteria 
will be relevant to each PDF; for example, many documents do not include forms. 

Making the content accessible in the source document is the easiest route to reducing 
the number of accessibility flags, so it is recommended to spend time on the source 
document before converting to PDF and running the checker tool. 

Each criterion is listed below with an overview of the criterion, the action to take if an 
error is raised, and one or more key resources.  

Note: There are two criteria that are always marked as requiring a manual check 
because they cannot be assessed by the tool. These are Color Contrast and Logical 
Reading Order. 

https://webaim.org/articles/screenreader_testing/
https://webaim.org/articles/nvda/
https://support.apple.com/en-gb/guide/voiceover/welcome/mac
https://webaim.org/articles/voiceover/
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Accessibility Permission Flag 
Overview: Security settings can block assistive technologies from perceiving and 
extracting text. The tool identifies if a PDF has security settings that restrict assistive 
technologies.  

Action: Either remove security settings or set the accessibility permission flag. 

Resource: Adobe – Prevent security settings from interfering with screen readers.  

Image-only PDF 
Overview: Image-only PDFs – often scanned documents – do not contain searchable 
text and cannot be read by assistive technology. The tool checks whether the PDF 
contains searchable text. 

Action: If the source document is not available to convert to a searchable PDF, use the 
Optical Character Recognition (OCR) tool in Adobe Acrobat to create accessible text. 

Resource: W3C – Performing OCR on a scanned PDF document to provide actual text. 

Tagged PDF 
Overview: A PDF’s tag structure enables assistive technologies to understand and 
navigate the document, such as headings, lists, tables, and images. The tool checks 
whether tags are present in the PDF. 

Action: If the source document is available, structure the content (such as including 
heading styles in Word or InDesign) and exporting to PDF as a ‘Tagged PDF’. 

If the source document is unavailable, use the ‘Automatically tag PDF’ tool to tag the 
document. Manually check the tag structure and reading order are correct using the Tag 
pane (see also section below on ‘Logical reading order’). 

Resources:  

- W3C – Providing headings by marking content with heading tags in PDF 
documents. 

- Microsoft – Add a heading in a Word document. 
- InDesign – Basics of paragraph and character styles. 

Logical reading order 
Overview: The reading order of a PDF is equivalent to the visual order; it determines the 
order for assistive technology and keyboard-only users. A logical reading order is critical 
for users to read the content in a way that makes sense, and which aligns with the 
intended flow. This is always a manual check.  

https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html#Perms
https://www.w3.org/WAI/WCAG21/Techniques/pdf/PDF7
https://www.w3.org/WAI/WCAG21/Techniques/pdf/PDF9
https://www.w3.org/WAI/WCAG21/Techniques/pdf/PDF9
https://support.microsoft.com/en-us/office/add-a-heading-in-a-word-document-3eb8b917-56dc-4a17-891a-a026b2c790f2
https://support.microsoft.com/en-us/office/add-a-heading-in-a-word-document-3eb8b917-56dc-4a17-891a-a026b2c790f2
https://helpx.adobe.com/indesign/using/paragraph-character-styles.html
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Action: Adding structure to the source document and exporting to PDF as a ‘Tagged 
PDF’ creates the logical structure. As a manual check criterion, follow the steps below 
to check the logical reading order. 

Open the Tags Panel. The list of tags in the panel is called the ‘Tag tree’. Use the 
keyboard up and down arrows to navigate through the tags, checking that the order of 
the tags matches the intended reading order of the content. The content associated 
with a tag will highlight on the screen as you navigate through the Tag tree. 

If the tags follow the reading order, this is considered to be in a logical order. Complex 
layouts that include graphics, footnotes/endnotes, tables, and forms may not convert in 
the correct reading order and may require adjustments using a remediation tool. 

Resources: W3C – Ensuring correct tab and reading order in PDF documents. 

Primary language 
Overview: The primary language assigned to a PDF tells assistive technology which 
language to use when reading and communicating the document. Where a document 
features multiple languages, the primary language is the default. Smaller sections in a 
secondary language are individually tagged. 

Action: Set the primary language in the source document and assign secondary 
languages to smaller sections of text such as translations.  

Resources:  

- W3C – Setting the default language using the /Lang entry in the document 
catalog of a PDF document. 

- W3C – Specifying the language for a passage or phrase with the Lang entry in 
PDF documents. 

Document title 
Overview: The document title displays in the tab containing the document or in the 
browser window. A descriptive title allows users to easily identify the document. 

Action: Complete the Title property in the source document’s file information. 
Alternatively, complete the PDF Title in the Document Properties. 

Resources:  

- W3C – Specifying the document title using the Title entry in the document 
information dictionary of a PDF document. 

- Microsoft Office – View or change the properties for an Office file. 

https://www.w3.org/WAI/WCAG21/Techniques/pdf/PDF3
https://www.w3.org/WAI/WCAG21/Techniques/pdf/PDF16
https://www.w3.org/WAI/WCAG21/Techniques/pdf/PDF16
https://www.w3.org/WAI/WCAG21/Techniques/pdf/PDF19
https://www.w3.org/WAI/WCAG21/Techniques/pdf/PDF19
https://www.w3.org/WAI/WCAG21/Techniques/pdf/PDF18
https://www.w3.org/WAI/WCAG21/Techniques/pdf/PDF18
https://support.microsoft.com/en-us/office/view-or-change-the-properties-for-an-office-file-21d604c2-481e-4379-8e54-1dd4622c6b75
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Bookmarks 
Overview: Bookmarks aid navigation in long documents. They display in the Bookmarks 
Panel for all users. 

Action: Create a table of contents in Word prior to conversion, add Bookmarks to an 
InDesign source document, or add bookmarks in Acrobat after conversion. However, be 
aware that Bookmarks added directly to the PDF may be overwritten if the source 
document is reconverted to PDF. 

Resource: W3C – Creating bookmarks in PDF documents. 

Color contrast 
Overview: PDF color contrast is a manual check. Sufficient contrast between the text 
and background color, and between non-text graphics, improves readability.  

Action: Use a tool such as the TPGi Colour Contrast Analyser or WebAIM Contrast 
Checker to manually check contrast ratios. 

WCAG sets minimum contrast ratios for large-sized and regular text:  

- Large-scale text (at least 18pt or 14pt and bold) has a contrast ratio of 3 to 1; 
- Regular text has a contrast ratio of 4.5 to 1. 

Non-text contrast ratio for graphical objects is 3 to 1 against adjacent color(s), such as 
between segments in a pie chart, or between adjacent, colored regions on a map. 

Resources:  

- TPGi Colour Contrast Analyser. 
- WebAIM Contrast Checker. 
- WCAG 1.4.3 Contrast (Minimum). 
- WCAG 1.4.11 Non-text Contrast. 

Tagged content 
Overview: Whereas ‘Tagged PDF’ (above) checks for the presence of tags in the 
document, the ‘Tagged content’ criterion checks that all page content in the document 
is tagged. All meaningful content must be tagged to provide structure for assistive 
technology to navigate and correctly convey it. Content that is not tagged will not be 
available to assistive technology users. Tags include elements such as headings, 
paragraphs, lists, tables, and figures. 

Action: Apply structure to the source document, including the use of heading styles 
and the built-in list and table functions.  

https://www.w3.org/WAI/WCAG21/Techniques/pdf/PDF2
https://www.tpgi.com/color-contrast-checker/
https://www.tpgi.com/color-contrast-checker/
https://webaim.org/resources/contrastchecker/
https://www.w3.org/WAI/WCAG21/Understanding/contrast-minimum.html
https://w3.org/TR/WCAG21#non-text-contrast
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If the source document is unavailable, use ‘Automatically tag PDF’ to tag the document. 
Manually check the tag structure and reading order are correct using the tag tree. 

Resources: 

- W3C – Providing headings by marking content with heading tags in PDF 
documents. 

- W3C – Using table elements for table markup in PDF documents. 
- W3C – Using List tags for lists in PDF documents. 
- Adobe – Edit document structure with the Content and Tags panels. 

Tagged annotations 
Overview: Annotations, including links, form fields and media are tagged properly so 
that assistive technology can perceive and read them. The most common accessibility 
error for tagged annotations is missing annotations for links. 

Action: Hyperlinks are live in the source document before converting to PDF and the 
link text meaningfully identifies the link’s purpose, such as this example:  W3C – 
Providing link text that describes the purpose of a link.  

Resource: W3C – Providing links and link text using the Link annotation and the /Link 
structure element in PDF documents. 

A note on printed URLs: There may be times when you would want to provide the full 
address of a web resource, for example when a document is intended to be printed. Be 
aware that a URL may be difficult to understand, particularly if it is lengthy and/or being 
read by screen reading software. 

Tab order 
Overview: The tab order matches the document structure. 

Action: Verify and adjust the Tab Order through the Accessibility Checker tool. 

Resources: 

- W3C – Ensuring correct tab and reading order in PDF documents. 
- Adobe – Tab Order – Create and verify PDF accessibility.  

Character encoding 
Overview: All text in the PDF is correctly coded. 

Action: Unicode fonts are used for text and special characters in the source document.  

Resource: Adobe – Character Encoding - Create and verify PDF accessibility. 

https://www.w3.org/WAI/WCAG22/Techniques/pdf/PDF9
https://www.w3.org/WAI/WCAG22/Techniques/pdf/PDF9
https://www.w3.org/WAI/WCAG22/Techniques/pdf/PDF6
https://www.w3.org/WAI/WCAG22/Techniques/pdf/PDF21
https://helpx.adobe.com/acrobat/using/editing-document-structure-content-tags.html
https://www.w3.org/WAI/WCAG21/Techniques/general/G91
https://www.w3.org/WAI/WCAG21/Techniques/general/G91
https://www.w3.org/WAI/WCAG21/Techniques/pdf/PDF11
https://www.w3.org/WAI/WCAG21/Techniques/pdf/PDF11
https://www.w3.org/WAI/WCAG21/Techniques/pdf/PDF3
https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html#TabOrder
https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html#CharEnc
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Tagged multimedia 
Overview: The tool checks that all multimedia content, such as videos or embedded 
audio, in the document is tagged. 

Action: Use the Tag Pane to assign tags to multimedia objects.  

Resource: Adobe – Tagged Multimedia – Create and verify PDF accessibility. 

Screen flicker 
Overview: The tool checks for elements that make the screen flicker. 

Action: If content causes screen flicker, remove or modify the content. 

Resources:  

- Adobe – Screen Flicker – Creative and verify PDF accessibility. 
- WCAG 2.3.1 Three Flashes or Below Threshold. 

Scripts 
Overview: The tool checks that the document’s scripts do not interfere with assistive 
technology. 

Action: Remove scripts identified by the tool. 

Resource: Adobe – Scripts – Check and verify PDF accessibility. 

Timed responses 
Overview: Documents that contain forms do not require users to respond within a fixed 
time.  

Action: Remove scripts that set fixed timed user responses. 

Resource: Adobe – Timed Responses – Create and verify PDF accessibility. 

Navigation links 
Overview: Navigation links are active and are not repetitive.  

Action: Check navigation links are live and correctly tagged. If the same link appears 
multiple times, provide the user with the option to skip it. 

Resource: Adobe – Accessible Links – Create and verify PDF accessibility. 

Tagged form fields 
Overview: All form fields are included in the tag structure. 

https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html#Multimedia
https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html?trackingid=KACNN#FlickerRate
https://www.w3.org/WAI/WCAG21/Understanding/three-flashes-or-below-threshold.html
https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html?trackingid=KACNN#Scripts
https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html?trackingid=KACNN#TimedResponses
https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html#NavLinks
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Action: If the source document is available, export to PDF as a ‘Tagged PDF’. If the 
source document is not available, form field tags can be manually assigned. 

Resource: Adobe – Tagged Form Fields – Create and verify PDF accessibility. 

Form field descriptions 
Overview: Form fields have an accessible text description (tool tip). 

Action:  Add text descriptions (tooltips) to the form fields. 

Resource: Adobe – Field Descriptions – Create and verify PDF accessibility. 

Figures alternate text 
Overview: Alt text provides a textual equivalent for an image, enabling people using 
assistive technology to receive the important information in the visual. The tool checks 
that images in the document either have alternative text or are marked as artefacts. 

- Informative images that convey information to the user should include 
descriptive alt text. 

- Purely decorative images, such as lines or colored backgrounds, are marked as 
artefacts.  

 

There is a separate section in this compendium on alt text: see Alt text for images.  

Whereas it is possible to include both short and long alt text in HTML and EPUB formats, 
a PDF contains a single alt text field. Elsevier’s guidelines for embedding alt text in a 
PDF are: 

- If the alt text consists of only a short description, include the short alt text. 
- If the alt text includes both long and short descriptions, include the long alt text. 

Action: Alt text can be added to images in the source document or in Adobe Acrobat.  

Resources:  

- W3C – Applying text alternatives to images with the Alt entry in PDF documents. 
- W3C – Hiding decorative images with the Artifact tag in PDF documents.  
- W3C Images Tutorial. 
- DIAGRAM Center Image Description Guidelines 
- WCAG 1.1.1 Non-text Content. 

Nested alternate text 
Overview: Screen readers will not read the alt text assigned to nested elements, and 
will instead read the alt text from the parent element. The tool identifies if alt text is 
present for nested elements. 

https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html?trackingid=KACNN#TaggedFormFields
https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html?trackingid=KACNN#FormFieldNames
https://www.w3.org/WAI/WCAG21/Techniques/pdf/PDF1
https://www.w3.org/WAI/WCAG22/Techniques/pdf/PDF4
https://www.w3.org/WAI/WCAG22/Techniques/pdf/PDF4
https://www.w3.org/WAI/tutorials/images/
http://diagramcenter.org/table-of-contents-2.html
https://www.w3.org/WAI/WCAG21/Understanding/non-text-content
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Action: The alt text assigned to nested elements can be removed using the Tags panel. 

Resources: Adobe – Nested alternate text – Create and verify PDF accessibility. 

Alternate text – associated with content 
Overview: Alternative content is associated with content on the page. The tool 
identifies where an element has is alt text but does not contain page content.  

Action: The alt text can be adjusted using the Tags panel. 

Resources: Adobe – Associated with content – Create and verify PDF accessibility. 

Alternate text – hides annotation 
Overview: The tool checker for alt text that hides an annotation. This occurs when an 
annotation is nested under a parent element with alt text. 

Action: The alt text can be adjusted using the Tags panel. 

Resources: Adobe – Hides annotation – Create and verify PDF accessibility. 

Other elements alternate text 
Overview: The tool checks for content that requires alt text that does not come under 
the earlier criterion ‘Figures alternate text’, such as multimedia and 3D models, and will 
raise a flag where it is missing. 

Action: Alt text can be added to images in the source document or in Adobe Acrobat. 

Resources: Adobe – Other elements alternate text – Create and verify PDF accessibility. 

Table rows 
Overview: The tool checks that table rows are placed in a tagged table container. 

Action: Adjust the Table in the source document and reconvert to PDF. Table rows can 
also be manually tagged in the PDF. 

Resources:  

- W3C – Using table elements for table markup in PDF Documents. 
- W3C – Using Adobe Acrobat Pro's Table Editor to repair mistagged tables. 

Table TH and TD 
Overview: Table header (TH) and table data (TD) cells are nested inside table rows (TRs).  

Action: Adjust the Table in the source document and reconvert to PDF. Table rows can 
also be manually tagged in the PDF. 

https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html#NestedAltText
https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html?trackingid=KACNN#AltTextNoContent
https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html?trackingid=KACNN#HiddenAnnot
https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html?trackingid=KACNN#OtherAltText
https://www.w3.org/WAI/WCAG21/Techniques/pdf/PDF6
https://www.w3.org/WAI/WCAG21/Techniques/pdf/PDF20


 

33 

Resource:  

- W3C – Using table elements for table markup in PDF Documents. 
- W3C – Using Adobe Acrobat Pro's Table Editor to repair mistagged tables. 

Table headers 
Overview: Table headers are corrected tagged as header cells (TH). 

Action: Adjust the Table in the source document and reconvert to PDF. Table rows can 
also be manually tagged in the PDF. 

Resources:  

- W3C – Using table elements for table markup in PDF Documents. 
- W3C – Using Adobe Acrobat Pro's Table Editor to repair mistagged tables. 

Table regularity 
Overview: Tables contain the same number of columns in each row, and rows in each 
column. 

Action: Tables that contain merged or split cells may need adjustment in the PDF to 
reflect the correct row spans and/or column spans. 

Resources:  

- W3C – Using table elements for table markup in PDF Documents. 
- W3C – Using Adobe Acrobat Pro's Table Editor to repair mistagged tables. 

Table summary 
Overview: A table summary can improve accessibility by explaining the purpose and 
structure of complex tables. Adobe lists this as an optional criterion. 

Action: A table summary can be added using the Fix Reading Order tool – see the 
resource for a step-by-step guide. 

Resource: Adobe – Summary – Create and verify PDF accessibility. 

List items 
Overview: Each individual list item is contained within the structure of a list. If the 
checker fails, one or more list items are tagged incorrectly.  

Action: Adjust the list in the source document and re-export to PDF. If the source 
document is not available, manually adjust the accessibility tags in the Tags panel. 

Resource: W3C – Using List tags for lists in PDF documents. 

https://www.w3.org/WAI/WCAG21/Techniques/pdf/PDF6
https://www.w3.org/WAI/WCAG21/Techniques/pdf/PDF20
https://www.w3.org/WAI/WCAG21/Techniques/pdf/PDF6
https://www.w3.org/WAI/WCAG21/Techniques/pdf/PDF20
https://www.w3.org/WAI/WCAG21/Techniques/pdf/PDF6
https://www.w3.org/WAI/WCAG21/Techniques/pdf/PDF20
https://www.w3.org/WAI/WCAG21/Techniques/pdf/PDF20
https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html?trackingid=KACNN#TableSummary
https://www.w3.org/WAI/WCAG21/Techniques/pdf/PDF21
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List Lbl and Lbody 
Overview: Each list item contains two elements: (1) a list item label (Lbl) for the number 
or bullet character and (2) a list item body (LBody) for the content.  If the checker fails, 
one or more elements is tagged incorrectly or missing. 

Action: Adjust the list in the source document and re-export to PDF. If the source 
document is not available, manually adjust the accessibility tags in the Tags panel. 

Resource: W3C – Using List tags for lists in PDF documents. 

Headings – appropriate nesting 
Overview: The headings in a document are sequential and nested correctly, i.e. 
Heading 2 follows Heading 1, Heading 3 follows Heading 2, without skipping levels. 

Action: Adjust the headings in the source document and re-export to PDF. If the source 
document is not available, manually adjust the accessibility tags in the Tags panel. 

Resource: W3C – Providing headings by marking content with heading tags in PDF 
documents. 

Appendix 1: Elsevier PDF tagging 
This section contains a list of PDF tags that Elsevier applies to its content. 

Content block Tag Elsevier application 
Elsevier logo <Figure> Enclose the Elsevier logo in a <Figure> tag 

Provide descriptive information for figure using the alt 
property: "Elsevier logo" 

Dedication <P>  
Acknowledgments 
(frontmatter) 
heading 

<H1>  

Preface heading <H1>  
Epilogue heading <H1>  
Copyright line <P>  
Figures <Figure> 

<Caption> or 
<Figure> 
<Caption><P> 

Tag the figure as <Figure> and caption as <Caption>. 
Mark sub-paragraphs within the caption as <P> 

Abstract <H2><P> Enclose Abstract header in <H2> tag. 
Tag the abstract text in <P> tag or multiple <P> tags 
where multiple paragraphs are present 

Biography / About 
the Authors / 
Editors 

<P> 
<Figure> 

Tag author biography as <P> 
Tag the author’s picture as <Figure> with alt tag 
containing the author’s name 

https://www.w3.org/WAI/WCAG21/Techniques/pdf/PDF21
https://www.w3.org/WAI/WCAG21/Techniques/pdf/PDF9
https://www.w3.org/WAI/WCAG21/Techniques/pdf/PDF9
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Quote <Quote> or  
<P><BlockQu
ote> 

<Quote> A portion of text referencing work from 
another author, inline within a paragraph 
 
<BlockQuote> A large portion of text referencing work 
from another author. Wrap <BlockQuote> in <P> 

Formula and 
Equations 

<Formula> Wrap in <Formula> tag 

Tables <Table>  Tables should contain the same number of columns 
in each row and rows in each column 

Table Caption <Caption>  Tag a table caption as <Caption>  
 Table Row <TR>  <TR> for a table row 
 Table Header <TH>  <TH> for a column heading cell 

Attributes for a <TH> table column header: Scope = 
Column 
Attributes for a <TH> table row header: Scope = Row 
Attributes for a <TH> table column header that spans 
multiple columns; for example, two columns: Scope 
= Column; Column Span = 2 

 Table Data <TD>  <TD> for a normal cell 
 Table Data (blank) <TD> Blank cells are tagged with empty <TD> 
Table Footer <TFoot> Table footnotes are tagged using this element. Inside 

<TFoot> content is tagged using <TR><TD> 
Nomenclature or 
Glossary or Key 
Terms or Acronyms 

<H2><L><Li> 
<Lbl> 
<LBody> 

Tag the Glossary header as <H2> 
Individual terms are tagged in a list 

Keywords or 
Acronyms (inline 
text) 

<P> E.g. Keywords: Master Data Management (MDM), 
Program, Strategy, Scope. 

Nested Lists <L><LI><Lbl><
LBody><L>.... 

Follow nested list as sublist 

References <H2><L><LI> 
<Lbl><LBody> 

Use <H2> for the Reference title. 
References section is tagged in a single list structure 
<L>, child of a <P> element.  
Use only one <P> and one <L> when the References 
section spans across multiple pages.  
E.g.  
Numbered: <H2>Reference <L><LI><Lbl>1.<LBody> 
NameandDate:<H2>Reference <L><LI><LBody> 

 Reference list body <LBody> Each reference is enclosed in a separate <LI> list 
item element 

 Reference label <Lbl> Numbered items are wrapped in <Lbl> and 
referenced text in <LBody>  

Further/suggested 
reading 

<H2> 
<L> 

Use <H2> for the Further Reading header. 
Enclose further reading items in a list structure <L> 

Useful addresses <P>   
Websites <Link>   
Appendix heading <H2>    
Bibliography 
heading 

<H2>    
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Questions and 
answers heading 

<H2>   

Content in a 
secondary language 
or with hyphenation 
breakings 

<Span> Span clause is used for language attributes and for 
breaking hyphenation words. 

Note: Recommendation to tag soft hyphens as 
<Artifact> to avoid NVDA screen reader software from 
announcing “soft hyphen” 

Footnotes <Reference> 
<Note> 
<Lbl> 

References to footnotes and affiliations (e.g. “a”), are 
enclosed in a <Reference> element and their 
corresponding footnote text is enclosed in <Note> 
The structure of the elements follows the logical 
reading order where the footnote text is read directly 
after its reference in the main text. This can be 
accomplished by placing the <Note> after the 
<Reference> tag (e.g. after the given author’s name), 
within the same <P> tag 

Page numbers <Artifact> Enclose all page numbers in <Artifact> tag 
Links <Link> 

<Link-OBJR> 
Link structure should consist of the following 
elements: 
- A parent <Link> tag 
- One or more child tag(s) containing the link text.  
- A Link–OBJR tag which is also a child of the 

<Link> tag 

QR codes <Figure> A single QR code is tagged as <Formula> with alt text 
that describes the purpose of the QR code. 

A list of QR codes is tagged as a list structure <L> 
including <Formula> tag with alt text 

 
Link back to section on PDF tagging.  
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Microsoft PowerPoint accessibility 
The following provides guidance on PowerPoint accessibility and links to key resources. 

Accessibility Checker 
The built-in Microsoft Accessibility Checker quickly checks a PowerPoint document and 
presents a list of actions to make it accessible. 

Find the Accessibility Checker in the Review tab and select ‘Check Accessibility’. 

In the Accessibility Checker results box that appears, you can also tick the box to keep 
the checker running while you work on a document, which places an accessibility 
status in the footer of the document. 

Run the checker tool before completing a document to verify many of the points below. 

Key resource: Microsoft – Improve accessibility with the Accessibility Checker. 

Filename and properties 
A PowerPoint contains file property metadata which describes the document and 
increases its online discoverability and search engine optimisation. The metadata 
entered in PowerPoint is also taken through to a PDF during conversion. 

Find the document properties under ‘Info’ in the File tab.  

Save the document in the format ‘.pptx’, to enable accessibility features such as the 
accessibility checker and testing. 

Key resources:  

- Microsoft – View or change the properties for an Office file. 
- WCAG 2.4.2 Page titled. 

Alt text for visual content 
Alt text provides a textual equivalent for an image, enabling people using screen readers 
to receive the important information in the visual. PowerPoints can include a 
combination of image types: 

- Informative: Images that convey information to the user contain alt text.  
- Decorative: Purely decorative images, such as lines or colored backgrounds, are 

marked as decorative and do not contain alt text.  
- Functional: Images that function as a link or button contain alt text that 

describes their purpose. 

https://support.microsoft.com/en-us/office/improve-accessibility-with-the-accessibility-checker-a16f6de0-2f39-4a2b-8bd8-5ad801426c7f#PickTab=Windows&picktab=windows
https://support.microsoft.com/en-us/office/view-or-change-the-properties-for-an-office-file-21d604c2-481e-4379-8e54-1dd4622c6b75
https://www.w3.org/WAI/WCAG21/Understanding/page-titled
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Add a contextually relevant description in the alt text field. 

There is a separate section in this compendium on alt text: see Alt text for images.  

Key resources:  

- Microsoft – Add alt text to visuals. 
- W3C Images Tutorial. 
- DIAGRAM Center Image Description Guidelines. 

Choosing a template 
If you are looking to create a new template, Microsoft has a range of accessible 
templates. Select New from the File menu and search in the Online Templates and 
Themes field for ‘accessible templates’.  

Key resource: Microsoft – Create accessible slides. 

Slide layout 
Where possible include a title at the top of the slide. Adding a unique descriptive title to 
each slide makes it easier for all users to navigate the presentation. Add a number or a 
way of distinguishing between slides with the same title. 

For slides where a title might not naturally appear, a hidden slide title (positioned off the 
page) can be added using the Microsoft Accessibility Checker.  

Key resource: Microsoft – Create accessible slides. 

Reading order 
Using the default slide layouts in PowerPoint assigns the reading order for the content 
on a slide, starting with the title and moving through the navigation order built into the 
slide layout. 

The Selection Pane (Home > Arrange > Selection Pane) can be used to check and adjust 
the reading order for a given slide. The Accessibility Checker will also raise a query 
where a default slide layout has not been used. 

The reading order in this pane is in reverse order. Assistive technologies will read the 
bottom item in the list first (usually the title) and work through each in turn. 

Key resource: Microsoft – Create Slides with an Accessible Reading Order. 

https://support.microsoft.com/en-us/office/make-your-powerpoint-presentations-accessible-to-people-with-disabilities-6f7772b2-2f33-4bd2-8ca7-dae3b2b3ef25#bkmk_winalttext
https://www.w3.org/WAI/tutorials/images/
http://diagramcenter.org/table-of-contents-2.html
https://support.microsoft.com/en-us/office/make-your-powerpoint-presentations-accessible-to-people-with-disabilities-6f7772b2-2f33-4bd2-8ca7-dae3b2b3ef25#bkmk_slideswin
https://support.microsoft.com/en-us/office/make-your-powerpoint-presentations-accessible-to-people-with-disabilities-6f7772b2-2f33-4bd2-8ca7-dae3b2b3ef25#bkmk_slideswin
https://support.microsoft.com/en-us/office/video-create-slides-with-an-accessible-reading-order-794fc5da-f686-464d-8c29-1c6ab8515465
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Font choice and font size 
Clear fonts for readability, such as Arial, Aptos or Calibri.  

Minimum font size of 18pt, with larger font size for headings. Bear in mind that the 
audience for a PowerPoint may not be sat in the same proximity to the presentation.  

White space around the text and visual content for a readable experience. 

Color contrast 
Ensure there is sufficient contrast between the text and background colors. The built-in 
Microsoft Accessibility Checker will identify insufficient color contrast. 

Key resources:  

- TPGi Colour Contrast Analyser 
- WebAim Contrast Checker 

Avoid using color or formatting alone to convey meaning 
Using formatting or color as the only way to convey meaning or emphasis may mean 
that users miss out on important information. This includes use of color; formatting 
such as bold, italic, or underline; or the style or size of font.  

Key resource: W3C – Use of Color. 

Informative links 
Avoid adding full hyperlink threads on PowerPoint slides. Instead, display meaningful 
text that clearly communicates what the user will find when they select it. For example, 
Elsevier Accessibility homepage. 

Use descriptive link text. Screen reader users have the ability to select from a list of all 
the links in a document, and unique, clear links are quickly identifiable. 

A note on printed URLs: There may be times when you would want to provide the full 
address of a web resource, for example when a document is intended to be printed. Be 
aware that a URL may be difficult to understand, particularly if it is lengthy and/or being 
read by screen reading software. 

Key resource: Microsoft – Add a Hyperlink to a Slide. 

Tables 
Add simple tables if needed, avoiding merged or split cells.  

https://www.tpgi.com/color-contrast-checker/
https://webaim.org/resources/contrastchecker/
https://www.w3.org/WAI/WCAG21/Understanding/use-of-color.html
https://www.elsevier.com/about/accessibility
https://support.microsoft.com/en-us/office/add-a-hyperlink-to-a-slide-239c6c94-d52f-480c-99ae-8b0acf7df6d9#OfficeVersion=Windows&officeversion=windows
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In the Design tab, check that the correct header row box(es) are checked. Click inside 
the table before doing the following: 

- Check the ‘Header Row’ box where the header appears in the top row. 
- Check the ‘First Column’ box where the header appears in the first column.  

Key resource: Microsoft – Tables in PowerPoint. 

Videos 
There is a separate section in this compendium on videos: see Video content 
accessibility. 

Include closed captions files for videos. 

Ensure that the visual information in the video is sufficiently described in the narrative 
and captioning. If there are pauses in the video where visual information is conveyed, 
add an audio description track. 

Test your PowerPoint with a screen reader 
Spot-check your PowerPoints using a screen reader such as Narrator (built-in with 
Windows) or VoiceOver (built-in with Mac). Navigate through the screens to check the 
reading order. 

Key resource: Microsoft – Test Accessibility with a Screen Reader for guidance on using 
Narrator. 

Further resources 
Microsoft - Make your PowerPoint presentations accessible to people with disabilities. 

WebAIM – PowerPoint accessibility. 

AHEAD – Accessible PowerPoint Presentations. 

University of Colorado Boulder – Understanding PowerPoint Accessibility.

https://support.microsoft.com/en-us/office/make-your-powerpoint-presentations-accessible-to-people-with-disabilities-6f7772b2-2f33-4bd2-8ca7-dae3b2b3ef25#bkmk_tableswin
https://support.microsoft.com/en-us/office/make-your-powerpoint-presentations-accessible-to-people-with-disabilities-6f7772b2-2f33-4bd2-8ca7-dae3b2b3ef25#bkmk_testwin
https://support.microsoft.com/en-us/office/make-your-powerpoint-presentations-accessible-to-people-with-disabilities-6f7772b2-2f33-4bd2-8ca7-dae3b2b3ef25#bkmk_topwin
https://webaim.org/techniques/powerpoint/
https://www.ahead.ie/wam-remoteworking-resources-powerpoint
https://www.colorado.edu/digital-accessibility/resources/understanding-powerpoint-accessibility
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Podcast and audio recordings accessibility  

Introduction  
If your platform or content includes any audio content, including podcasts, interviews, 
recorded presentations, or other audio materials, you should ensure that content is 
accessible to all readers. This includes people who are deaf or hard of hearing, as well 
as those who cannot hear audio in their current environment or prefer reading over 
listening.  

The legal bottom line: Audio content falls under the Americans with Disabilities Act 
(ADA) in the United States and the European Accessibility Act (EAA) in Europe. Both laws 
require digital content to meet accessibility standards. WCAG 2.1 Level AA is the 
technical standard for both regulations and reference.  

Your responsibility: Whether you create audio content in-house or hire a vendor to 
produce or host it, you are responsible for ensuring the final published content meets 
accessibility requirements. This means verifying that transcripts are 
complete, accurate, and properly formatted before content goes live. When delivering 
audio content for publication on Elsevier platforms, it is important that we receive your 
captions and transcripts at the same time. The standards apply to your content 
regardless of where it is published. 

Requirements  
Every podcast episode, interview recording, or audio file should include a 
complete, accurate text transcript.  

What the transcript should include:  

- All spoken words. Your transcript should contain everything said, exactly as it is 
said, by every speaker.  

- Speaker identification. Clearly label each speaker by name at the start of each 
new speaker's contribution (for example, "Dr. Smith:" or "Interviewer:"). This is 
essential for episodes with multiple speakers.  

- Significant non-speech audio. Include descriptions of important sounds that 
convey meaning, enclosed in brackets. Examples include [applause], 
[background music], [laughter], and [sound of papers shuffling]. You can omit 
ambient noise that does not affect understanding.  
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- Timestamps. Include timestamps at logical breaks (speaker changes, section 
breaks) in the format [MM:SS] or [HH:MM:SS]. This allows readers 
to locate specific content and verify quotes.  

Transcript format requirements  
- Save the transcript in an accessible TXT format.  

- Use clear formatting: bold speaker names, section headings, single or 1.5-
line spacing, and blank lines between speakers or paragraphs for readability.  

Transcript display and availability requirements 
The transcript should be available on the same web page where the audio can be 
played. Platforms have several options for how to make the transcript available: 

- Displayed on the page. The transcript can be displayed alongside or beneath 
the audio player as readable text on the page itself. This is the most accessible 
option and allows readers to follow along while listening or to read instead of 
listening. 

- Downloadable file. If the full transcript is not displayed on the page, the 
platform should provide a clearly labeled download link for the transcript file. 
The link should be positioned near the audio player and use descriptive text such 
as "Download Transcript" or "Download Full Episode Transcript." 

- Both options. The platform can offer both a displayed transcript and a 
downloadable file for maximum flexibility. 

Important note about audio players 
A platform’s audio player does not need to have built-in transcript support or display 
capabilities. Many audio players and podcast hosting platforms do not include these 
features, and that is perfectly acceptable. When an audio player does not support 
transcript display or download, the platform provider is responsible for making the 
transcript available separately on the page. This can be accomplished by displaying the 
transcript as text directly on the page below the audio player or by providing a download 
link to the transcript file positioned near the audio player. 

Accuracy standard  
Transcripts should be accurate. If you use automated transcription tools, review and 
correct the transcript before publication. Pay special attention to:  



 

43 

- Speaker names and affiliations;  

- Technical or scientific terminology;  

- Proper nouns and institutional names;  

- Numerical data or citations.  

Clarifying responsibilities: internal production 
vs. vendor produced content  
If you produce the audio: You are responsible for creating or obtaining the transcript and 
ensuring it meets the requirements listed above.  

If a vendor or service provider produces the audio: Your contract or service agreement 
should specify:  

- The vendor will deliver a transcript along with the final audio;  

- The transcript will meet the formatting and accuracy standards outlined in the 
Requirements section; 

- You will verify the transcript before publication.  

Resources  

Tools and services for obtaining transcripts  
You do not need to manually transcribe audio. Several services can generate transcripts 
for you. 

Automated AI transcription services (cost-effective for initial transcript generation, 
though they require review for accuracy): 

- Otter.ai: A popular AI-powered tool that provides real-time transcription with 
speaker identification. Particularly useful for meetings and interviews, with 
collaborative editing features.  

- Descript: An all-in-one platform that combines AI transcription with audio and 
video editing. Its unique text-based editing approach lets you edit audio by 
editing the transcript.  

- Rev (AI tier): Fast, affordable AI-generated transcripts with quick turnaround. 
Best for straightforward content, though technical terminology may need review.  

Professional transcription services (human-verified for accuracy, with higher cost but 
recommended for specialized content):  

https://otter.ai/
https://www.descript.com/transcription
https://www.rev.com/automated-transcription
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- Rev (Premium tier): Human transcriptionists ensure high accuracy with better 
handling of difficult audio, specialized vocabulary, and multiple speakers. Ideal 
for scientific or academic content.  

- 3Play Media: Comprehensive accessibility solutions provider combining AI with 
human review. Features designed for WCAG and ADA compliance standards.  

- Verbit: Enterprise-grade service using AI combined with professional human 
verification. Specializes in complex, high-stakes content such as legal 
proceedings, academic lectures, and corporate communications.  

Free manual transcription tools: If you prefer to create transcripts manually or need 
precise control over formatting, these free tools can help:  

- oTranscribe: Browser-based tool with interactive timestamps, playback speed 
control, and keyboard shortcuts.  

- Audacity: Free audio editing software that lets you slow down playback, add 
labels at specific timestamps, and export text files.  

- Express Scribe (Free version): Dedicated transcription software with foot pedal 
support, variable playback speed, and keyboard hotkeys.  

Manual transcription tips: use keyboard shortcuts to pause and play without switching 
windows. Slow playback to 75 to 80 percent speed for dense content. Insert 
timestamps as you go rather than adding them later.  

How to choose a service  
Consider your accuracy requirements, timeline, budget, and content volume. For 
scientific or specialized content, we strongly recommend professional services or AI 
services followed by careful manual review to ensure technical terms and proper nouns 
are correct.  

Official standards and guidelines  
- WCAG 2.1 Success Criterion 1.2.1: The official W3C explanation of requirements 

for prerecorded audio-only content with practical examples and techniques;  

- W3C Making Audio and Video Media Accessible: Comprehensive guidance on 
creating accessible multimedia content from the Web Accessibility Initiative.  

Practical guides from accessibility experts  
- The A11Y Project Guide to Transcripts: Community-driven resource explaining 

what transcripts are and why they matter;  

- Nomensa: How to Write a Good Transcript: Detailed walkthrough of transcript 
formatting and quality standards from a leading accessibility consultancy.

https://www.rev.com/transcription
https://www.3playmedia.com/solutions/features/transcription/
https://verbit.ai/solutions/transcription/
https://otranscribe.com/
https://www.audacityteam.org/
https://transcribe.wreally.com/
https://www.w3.org/WAI/WCAG21/Understanding/audio-only-and-video-only-prerecorded.html
https://www.w3.org/WAI/media/av/
https://www.a11yproject.com/posts/what-are-transcripts/
https://www.nomensa.com/blog/how-write-good-transcript
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Video content accessibility  

Introduction  
Video content is one of the most powerful ways to share information, tell stories, and 
connect with audiences. However, not everyone experiences video in the same way. 
People who are deaf or hard of hearing cannot access spoken content. People who are 
blind or have low vision may miss important visual details. Making video content 
accessible means ensuring that everyone can understand and engage 
with your content, regardless of their abilities.  

Creating accessible video content is also good for your audience and your organization. 
Accessible videos reach more people, improve the user experience for everyone, and 
support your commitment to inclusion and equality.  

Requirements  
The core requirements for video accessibility are: 

- Every video that includes speech includes captions in a closed caption format, 
and an untimed text transcript. 

- Every video that includes important visual information 
includes audio description or a descriptive transcript.  

The specific requirements depend on the type of video content you create. 

Captions for prerecorded video  
If your video includes speech, you should provide closed captions. Captions are the text 
version of the spoken words and important sounds in your video. They appear on the 
screen at the same time as the audio.  

File deliveries: Closed captions should be delivered as TTML and webVTT files, 
alongside a TXT transcript document (details in Transcripts for prerecorded video).  

File naming: Match the description file name with the video file name, ending with .vtt. 
For example, to tag English closed captions the suffix should read -cc-en.vtt. French 
closed captions would read -cc-fr.vtt.  

 Captions should include:  

- All spoken dialogue and narration;  
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- The name or label of the person speaking when there are multiple speakers;  

- Descriptions of important sounds such as music, laughter, applause, footsteps, 
doors closing, or background noises that add meaning to the content. These are 
captured in brackets; for example, [heartbeat slows];  

- Accurate spelling, grammar, and punctuation.  

Captions should be synchronized with the audio. This means the text appears at the 
same time the words are spoken or the sounds occur.  

Captions should be easy to read. They are not obscured by, and do not obscure, the 
visual content. Default placement is centered in the bottom two lines of the screen, but 
placement can vary depending on the content of the video.  

Keep each line of text short, with no more than 32 characters per line and no more than 
two lines of text on the screen at the same time. Each caption should stay on the screen 
for at least one second.  

Apply WCAG visual presentation principles to make sure the text is clear: 

- Use a font size of 12pt or above. 

- Text smaller than 24px font size has a 4.5 to 1 contrast ratio against its 
background; 

Text larger than 24px can have a contrast ratio of 3 to 1. 

Appendix 2: Elsevier video closed captioning contains the requirements that Elsevier 
applies to its journal videos.  

This compendium also includes a section on audio: 
see Podcast and audio recordings accessibility.  

Creating captions  
You have several options for creating captions. 

Automatic captions  
Many video platforms such as YouTube, Vimeo, and Zoom can automatically generate 
captions using speech recognition technology. Automatic captions are created quickly 
and at no cost.  

However, automatic captions are not accurate enough on their own. Studies show that 
automatic captions are typically 60% to 80% accurate under ideal conditions. Accuracy 
can drop to 50% or lower if the audio quality is poor, the speaker has an accent, or the 
content includes technical terms or names.  
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You should always review and edit automatic captions before you publish your video. 
Inaccurate captions can confuse viewers or provide incorrect information.  

Manual captions  
You can create captions manually by typing the text as you watch the video. Most video 
platforms include a caption editor that allows you to type captions and set the timing for 
each line of text. This method takes more time than using automatic captions but gives 
you full control over accuracy.  

Professional captioning services  
You can hire a professional captioning service to create captions for your video. 
Professional services typically provide captions with 99% or higher accuracy. Some 
services use human transcribers, while others use a combination of automatic speech 
recognition and human review. 

Uploading caption files  
Most video platforms allow you to upload caption files in standard formats such as SRT 
(SubRip Subtitle) or VTT (WebVTT). If you create captions outside of the platform or hire 
a captioning service, you can upload the caption file to your video.  

Caption files are simple text files that include the text of the captions, and the time 
codes that indicate when each caption should appear. You can create and edit caption 
files using free tools or text editors.  

Note about platform features: Platforms such as YouTube and Vimeo allow you to 
create, edit, and upload captions directly on their platforms. You do not always need to 
create separate caption files or use external tools. Check the help documentation for 
your video platform to learn what caption features are available.  

Captioning resources 
Captioning tools and services 
Rev provides automatic and human-generated captions with up to 99% accuracy. Good 
for high-quality captions. Paid service.  

Otter.ai is an automatic transcription tool that works for live and prerecorded video. 
Includes a free plan. Good for quick automatic captions.  

3Play Media provides professional captioning and audio description services. Good for 
large volumes of content or when you need both captions and audio description. Paid 
service.  

https://www.rev.com/
https://otter.ai/
https://www.3playmedia.com/
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Caption file editors  
Subtitle Edit is a free caption editor for Windows. It supports more than 300 caption 
formats and includes audio waveform display.  

Aegisub is a free caption editor for Windows, macOS, and Linux. Good for detailed 
caption editing and timing. Free to use.  

Platform help documentation  
How to Add Captions on YouTube provides step-by-step instructions for creating and 
uploading captions in YouTube Studio.  

How to Add Captions on Vimeo explains how to upload caption files and enable 
captions for your videos.  

Captions for live video  
If you broadcast live video with audio, you should provide live captions. Live captions 
are created in real time as the video is broadcast. You can use live captioning services 
or automatic speech recognition tools to create live captions. Always review the quality 
of live captions before and during your broadcast to ensure they are accurate.  

Transcripts for prerecorded video 
Transcripts are text documents that include all of the spoken words and descriptions of 
sounds in your video. Transcripts are helpful for many users, including people who are 
deaf and blind, people who prefer to read rather than watch, and people who want to 
search for specific information in your video.  

Transcripts are not required for all video content under accessibility regulations. 
However, they are strongly encouraged because they improve the accessibility, 
discoverability, and usability of your video. Transcripts improve search engine 
optimization, making your content easier to find online.  

Check whether the platform that you are creating content for requires a transcript.  

If you provide a transcript, it should include:  

- All spoken dialogue and narration; 

- Speaker identification; 

- Descriptions of important sounds, captured in brackets; for example, [heartbeat 
slows]; 

- Descriptions of important visual information if the video includes visual content.  

https://www.nikse.dk/subtitleedit
https://aegisub.org/
https://support.google.com/youtube/answer/2734796
https://vimeo.com/help
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The text transcript document should be delivered in the file format TXT.  

Transcripts should be easy to find. You can include the transcript in the video 
description, link to it from the video page, or publish it on a separate webpage.  

Sign language interpretation  
Sign language interpretation is not required for most video content. However, it is a 
valuable accessibility feature for people who use sign language as their primary 
language. If you include sign language interpretation, the interpreter should be visible in 
the video and large enough for viewers to see clearly. 

Content is typically interpreted into sign language, rather than translated. All 
spoken/written terms do not have a sign language equivalent, and for this reason some 
content (especially very technical content) is not always suitable for sign language 
interpretation. 

There are multiple sign languages and, while they have some similarities, one sign 
language may not always be understood by a speaker of a different sign language. 
American Sign Language (ASL) and British Sign Language (BSL) are highly used. 

Resources for transcription 
- Trint converts audio and video files to text in more than 40 languages. You can 

export transcripts as caption files. Paid service.  

- Descript is a video and audio editor with automatic transcription. You can 
edit videos by editing the text. Includes a free plan. 

- See also the compendium section on Podcast and audio recordings accessibility. 

Audio description for prerecorded video  
If your video includes important visual information that is not explained in the audio, you 
should provide audio description. Audio description is a spoken narration that 
describes the visual content of your video.  

Audio description includes:  

- Actions and movements that are important to understanding the content;  

- Text that appears on the screen such as titles, labels, captions, or slides;  

- Changes in setting or scene;  

- The appearance of people or objects when this information is important;  

- Facial expressions or gestures that communicate meaning.  

https://trint.com/
https://www.descript.com/
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Audio description is added during pauses in the dialogue or narration. The description 
should be clear and concise so it fits naturally into the available time.  

Not all videos need audio description. If all of the important information in the video is 
already spoken in the audio, you do not need to add audio description. For example, a 
video of a person speaking directly to the camera where no additional visual information 
is shown may not need audio description.  

Note about creating audio description: Some platforms such as YouTube allow you to 
upload a separate audio description file directly to the platform. On other platforms, 
you may need to create a second version of your video that includes the audio 
description mixed into the main audio track. 

Creating audio description  
You have several options for creating audio description.  

Write a script  
The first step is to write a script that describes the important visual information in your 
video. Watch your video carefully and identify the visual content that is not explained in 
the audio. Write clear, concise descriptions that fit into the natural pauses in the 
dialogue or narration.  

Focus on describing what you see, not interpreting what it means. For example, write 
"Sarah points to the chart" instead of "Sarah seems excited about the data."  

Record the audio description  
Once you have a script, you need to record the audio description. You can hire a 
professional narrator or use text-to-speech software to create the recording. The voice 
should be clear and easy to understand.  

Using professional audio description services  
You can hire a professional audio description service to create audio description for 
your video. Professional services will write the script, record the narration, and deliver 
the audio description file in the format you need.  

Add the audio description to your video  
After you have recorded the audio description, add it to your video. You have two options:  

- Create a second version of your video with the audio description mixed into the 
main audio track. Users can choose to watch the version with or without audio 
description. 
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- Upload the audio description as a separate audio track if your video platform 
supports this feature. Users can turn the audio description on or off while 
watching the video.  

Some platforms such as YouTube now support audio description as a separate track. 
Other platforms may require you to create two versions of your video.  

Note about platform features: Some platforms allow you to upload audio description 
files directly. You do not always need to create a second version of your video. Check 
the help documentation for your video platform to learn what audio description features 
are available.  

Resources for audio description services 
- 3Play Media Audio Description provides professional audio description with 

flexible output formats. Paid service.  

- Rev Audio Description provides professional audio description with human 
describers. Paid service.  

General accessibility guidance  
Web Content Accessibility Guidelines (WCAG) provides international accessibility 
standards for web content, including video requirements.  

Making Audio and Video Media Accessible is a practical guide from the Web 
Accessibility Initiative with examples, best practices, and links to additional resources.  

Appendix 2: Elsevier video closed captioning  
This section contains a list of closed captioning requirements that Elsevier applies to its 
content.  

Text   
Case: Mixed case characters are to be used for readability. However, capital letters are 
used for an individual word or a single phrase to denote emphasis or shouting.  

Font: A font, or typeface, is a set of characters at a certain size, weight, and style. 
Consistency throughout the media is extremely important.  Elsevier's base font 
requirements are as follows:  

The font should include upper- and lowercase letters with descenders that drop below 
the baseline. Do not allow overlap with other characters, ascenders, or descenders.    

https://www.3playmedia.com/platform/audio-description
https://www.rev.com/
https://www.w3.org/WAI/standards-guidelines/wcag/
https://www.w3.org/WAI/media/av/
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Caption Backdrop: The default background color for captions should be a black text 
box to show the white text color clearly.  

Line division  
When a sentence is broken into two or more lines of captions, it should be broken at a 
logical point where speech normally pauses unless it would exceed the 32-characters-
per-line requirement.  

Caption placement  
Caption placement (vertical and horizontal) refers to the location of captions on the 
screen. Placement can vary, depending on the content of the video.  

• Captions default placement is centered in the bottom two lines of the screen.  

• Do not put more than two lines per caption except where exceptions are 
noted below.  

• Captions that have two lines should have left-aligned text.   

• For media with one offscreen narrator and no preexisting graphics, captions 
should be left-aligned at center screen on the bottom two lines.  

• Single-line captions should be centered on the bottom line.  

• Three- or four-line captions are acceptable only if a one- or two-line caption 
would interfere with preexisting graphics or be confusing with regard to speaker 
identification.   

• Captioned dialogue should be placed under the speaker as long it does not 
interfere with graphics or other preexisting features  

Language mechanics  
Spelling and capitalization  

• Be consistent in the spelling of words throughout the production, including 
vocabulary that can be spelt either as one or two words or in hyphenated form. 
For conventional words, dictionaries, and style guides should be followed.  

• Do not emphasize a word using all capital letters except to indicate screaming.  

• Capitalize proper nouns for speaker identification. All other speaker 
identification should be lowercased unless this identification is being used as a 
proper noun.   

• Lowercase sound effects, including both description and onomatopoeia, except 
when a proper noun is part of the description.   
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Punctuation and grammar  
• Always follow conventional rules of Standard English to the greatest extent 

possible (unless indicated differently by the producer), utilizing style guides to 
reach sound decisions.  

• Captioning spontaneous speech can be very difficult, as real conversations 
often contain improper grammar or run-on sentences, dialect, and slang. 
Problems are compounded with restrictions of time and space. As punctuation 
cannot correct non-grammatical speech, its role in captioning is 
to facilitate clarity and ease of reading.  

• When word order alone is not sufficient to establish the relationships between 
words, it may be necessary to resort to punctuation that is sometimes unique to 
the captioning process.  

Hyphens and dashes  
• Nonessential information that needs special emphasis should be conveyed by 

double hyphens or a single long dash.  

• When a speaker is interrupted and another speaker finishes the sentence, the 
interruption should be conveyed by double hyphens or a single long dash.  

• When a speaker stutters, caption what is said.    

• When captioning spelling (including fingerspelling), separate capital letters with 
hyphens.   

Quotation marks  
• Use quotation marks for onscreen readings from a poem, book, play, journal, or 

letter. However, use quotation marks and italics for offscreen readings or voice-
overs.  

• Beginning quotation marks should be used for each caption of quoted material 
except for the last caption. The last caption should have only the ending 
quotation marks.    

Spacing  
• Spaces should not be inserted before ending punctuation, after opening and 

before closing parentheses and brackets, before and after double hyphens and 
dashes, or before/between/after the periods of an ellipsis.   

Sound effects  
• Sound effects are sounds other than music, narration, or dialogue. They are 

captioned if it is necessary to the understanding of the media.  
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• A description of sound effects, in brackets, should include the source of the 
sound.  

• Description can be eliminated if the source of the sound can clearly be seen 
onscreen.   

• Place the description of the sound effect as close as possible to the sound 
source.  

Speaker identification  
• Establishing the identity of both onscreen and offscreen speakers is vital for 

clarity. When names are unknown, be as specific as possible in providing a 
label.  

• Use caption placement to identify an onscreen speaker by placing the caption 
under the speaker.  

• If offscreen speakers are speaking simultaneously, appropriate 
speaker identification should be added.  

• When a speaker cannot be identified by placement and his/her name is 
unknown, identify the speaker using the same information a hearing viewer has 
(e.g., “female #1,” “male narrator”).  

• Do not identify the speaker by name until the speaker is introduced in the audio 
or by an on-screen graphic.  

• If there is only one narrator, identify as (male narrator) or (female narrator) at the 
beginning of the media. It is not necessary to identify gender for each caption 
thereafter.  

Synchronization  
Captions should closely match the original audio.  

• Borrowing 15 frames before and after the audio occurs is hardly noticeable to the 
viewer. This “borrowing” technique can be used only when presentation rate is a 
factor.  

• Do not simultaneously caption different speakers if they are not speaking at the 
same time.  

Special Considerations  
When a word is spoken phonetically, caption it the way it is commonly written.   
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Numbers  
• Unless otherwise specified, spell out all numbers from one to ten, but use 

numerals for all numbers over ten.  

• Spell out any number that begins a sentence as well as any related numbers.   

• Spell out nonemphatic numbers.   

• Numerals with four digits can either have a comma or not. Be consistent 
throughout the media production. For numerals having over five digits, a comma 
is necessary.   

• Use numerals in a listing of numbers if one or more is above ten and these occur 
in one caption or one sentence.   

• Use numerals when referring to technical and athletic terms.   

• When indicating sequence, capitalize the noun and use numerals. Exceptions 
are the indication of line, note, page, paragraph, size, step, or verse.   

Dates  
• Use the numeral plus the lowercase “th,” “st,” or “nd” when a day of the month is 

mentioned by itself (no month is referred to).   

• When the day precedes the month, use the numeral plus the lowercase “th,” “st,” 
or “nd” if the ending is spoken.   

• Use the numeral alone when the day follows the month.   

• When the month, day, and year are spoken, use the numeral alone for the day, 
even if an ending (“th,” “st,” or “nd”) is spoken.  

Time  
•  Indicate time of day with numerals only.   

• Always use numerals when the abbreviation “a.m.” or “p.m.” is present. Double 
zeros are not necessary to indicate minutes of the hour when a whole number is 
used with a.m. or p.m.   

Periods of time  
•  A decade should be captioned as “the 1980s” (not “the 1980’s”) and “the ’50s” 

(not “the 50’s”).  

• If a decade or century is in noun form, do not use hyphens.   

• If a period of time is used as an adjective, use a hyphen.   
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Fractions  
• Either spell out or use numerals for fractions, keeping this rule consistent 

throughout the media. If using numerals, insert a space between a whole 
number and its fraction.   

• Do not mix numerals and spelt-out words within the same sentence.   

• If a fraction is used with “million,” “billion,” “trillion,” etc., spell out the fraction.   

• Fractions expressed in figures should not be followed by endings, such as “sts,” 
“rds,” “nds,” or “ths.”   

Percentages  
• Use numerals and the per cent sign to indicate all percentages except at the 

beginning of a sentence.    

Measurements  
• Spell out units of measurement, such as “inches,” “feet,” “yards,” “miles,” 

“ounces,” “pounds,” and “tablespoons.” However, if spoken in shortened form, 
symbols should be used. For example, if the original narration is “I’m five eight,” it 
should be captioned as:  I’m 5'8".  

• For whole numbers, use numerals. For example, caption “3 cups of sugar” 
instead of “three cups of sugar.”  

Link back to section on Captions for prerecorded video. 

 



 

57 

Animations Accessibility 

Introduction 
Animations are movements you see on websites, presentations, and digital platforms. 
These include items that slide, fade, spin, zoom, or change position. Animations can 
make content more engaging, but they can also create serious problems for many 
people. 

Moving content can cause dizziness, nausea, headaches, and migraines for people with 
vestibular disorders, which affect balance and the inner ear. Animations can also trigger 
problems for people with epilepsy, migraines, attention disorders, autism, and cognitive 
disabilities. Even people without these conditions may find too much motion distracting 
or uncomfortable. 

Requirements 
Core requirement: Any moving content that starts automatically, lasts more than five 
seconds, and appears with other content should provide a way for users to pause, stop, 
or hide it. Motion triggered by user actions should also be able to be turned off unless 
the motion is essential to the function or information. 

What counts as animation that needs controls 
Treat the following movement as animation that may need controls or alternatives: 

- Scrolling effects: Parallax scrolling, elements fading or sliding in, jumping 
between sections. 

- Background and page motion: Autoplaying video backgrounds, page 
transitions, moving patterns, or particles. 

- Popups and overlays: Modals, dialogs, sidebars, and toasts that slide, bounce, 
or zoom in. 

- Slideshows and carousels: Content that rotates or moves automatically. 

- Repeating image animations: Looping GIFs, cinemagraphs, and continuously 
animating icons. 

- Interactive component motion: Animating accordions, flipping cards, bouncing 
buttons, and shaking error indicators. 
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- Loading and status indicators: Spinning loaders, pulsing effects, and animated 
progress bars lasting over five seconds. 

- 3D and depth effects: 3D transforms, zoom effects, and blur changes 
simulating depth. 

- Typography and graphic animations: Moving text, kinetic typography, morphing 
logos, and transforming SVG shapes. 

- Autoplaying videos outside media players: Promotional clips or background 
videos with camera movement or quick scene changes. 

If unsure whether something is animation, ask: does anything move or change position, 
size, rotation, or depth over time? 

If yes, treat it as animation that may affect user wellbeing. 

What you should do 
Content creators should: 

- Provide visible controls for moving content: Include a clear way to pause, 
stop, or hide any animation that plays automatically for more than five seconds. 
Use simple labels like "Pause animation" or "Stop motion". 

- Ensure that pause really stops motion: When users pause or stop, the 
animation should not restart by itself. 

- Respect reduced motion preferences: When reduced motion is enabled in 
device settings, animations should stop, simplify, or switch to static alternatives. 

- Avoid autoplaying motion where possible: Let users choose when motion 
begins by using a play button or other clear action. 

- Avoid autorotating carousels: Carousels and sliders should not move 
automatically. Users should control navigation at their own pace. 

- Describe important animated content in text: When animation communicates 
important information, provide the same information as text near the animation. 

What you could do for better accessibility 
These practices create a safer experience for many users: 

- Keep animations brief and gentle: Use short, slow animations. Subtle 
movement causes less discomfort. 

- Limit how far things move: Avoid large movements across the screen. Smaller 
changes are easier to tolerate. 
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- Prefer fades over slides and zooms: Fades feel calmer, especially for small 
interface changes. 

- Avoid large area motion: Do not animate big backgrounds or full screen 
transitions if a smaller change works. 

- Never use flashing effects: Flashing or strobing content can trigger seizures 
and severe discomfort. 

- Replace decorative motion with static design: If an animation adds no value, 
use a still image instead. 

- Warn users about heavy motion: If you cannot remove strong motion, add a 
warning like "This section includes animation" so people can choose whether to 
continue. 

Visual presentation of information 
- If animation contains text, apply WCAG visual presentation principles to make 

sure the text is clear: 

o Use a font size of 12pt or above; 

o Text smaller than 24px font size has a 4.5 to 1 contrast ratio against its 
background; 

o Text larger than 24px has a contrast ratio of 3 to 1; 

o Apply a line height of at least 1.5 times its font size; for example, text set in 
14px has a line height of at least 21px (14×1.5=21); 

o Spacing between paragraphs has at least two times the font size. For 
example, 14px text has at least 28px space between paragraphs. 

- Presenting colored text on backgrounds of a different color can be difficult to 
read for some and should be avoided. For example, red text should not appear 
on a blue background; a neutral (e.g. grey) or similar color (e.g. lighter red) 
background would be preferred, applying the above color contrast requirements.  

- Never rely on color alone to convey meaning. Visual presentations of information 
should be legible for viewers with sight limitations (such as colorblindness). A 
quick check for this is to convert a graphic to black and white and see if you can 
still understand what is being communicated. 

- Color keys should be avoided whenever possible. The use of direct labeling is a 
simple approach to ensure this is met. 
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- In some circumstances, such as when presenting multiple layers of information 
at once, splitting information across multiple visualizations may be a method for 
achieving direct labeling. 

- If the use of a color key is unavoidable, the addition of patterns can convey the 
same information in a manner that does not depend on color alone. 

- Icons can be another method to communicate information in a way that is not 
solely dependent on color, when direct labeling is unsuitable.  

- Use of color is essential for complying with accessibility legislation such as ADA 
Title II. All graphic elements that communicate information should have a 
contrast of at least 3 to 1 against its background. Examples of application 
include icons, patterns, and data visualizations (e.g. data lines on a chart, bars 
on a graph). 

- This 3 to 1 contrast is also a requirement for the video player user interface. 

- WCAG recommends a minimum size for interactive targets such as buttons and 
controls of 24×24px). 

Resources 

Tools to test reduced motion support 
Animation and motion tester: Free tool to test how animations behave with reduced 
motion. Toggle reduced motion to check if movement stops or simplifies. 

Chrome DevTools documentation: Chrome and Chromium browsers can emulate 
reduced motion preferences. Useful for confirming that pages respect user motion 
settings. 

Tools to pause or convert animations 
Pause a GIF: Free tool that freezes an animated GIF on a frame and saves it as a still 
image. Use it to create static alternatives for looping GIFs. 

Guidance and documentation 
WebAIM carousels article: Plain language guide on carousel accessibility. Covers auto 
rotation and pause controls. 

Pause, Stop, Hide understanding document: Explains when to provide controls for 
moving content. Includes practical examples. 

https://www.infyways.com/tools/animation-motion-tester/
https://developer.chrome.com/docs/devtools/
https://onlinegiftools.com/pause-gif
https://webaim.org/techniques/carousels/
https://www.w3.org/WAI/WCAG21/Understanding/pause-stop-hide.html
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Animation from Interactions understanding document: Requirements for motion 
triggered by user actions. Helps determine when animations should be removable. 

Prefers reduced motion article: Explains how reduced motion settings work and why 
they matter. 

Vestibular website accessibility guide: Explains how animations affect people with 
vestibular conditions. 

Platform-specific resources 
Microsoft PowerPoint accessibility guide: Official Microsoft instructions for creating 
accessible presentations. Includes practical advice on using animations and transitions 
sparingly. 

Autoplaying videos and accessibility: Explains when autoplaying videos create 
accessibility barriers. Covers how to handle them more inclusively, including respecting 
reduced motion preferences and providing user controls. 

https://www.w3.org/WAI/WCAG22/Understanding/animation-from-interactions.html
https://web.dev/articles/prefers-reduced-motion
https://vestibular.org/blog/veda-website-accessibility-guide/
https://support.microsoft.com/en-us/office/make-your-powerpoint-presentations-accessible-to-people-with-disabilities-6f7772b2-2f33-4bd2-8ca7-dae3b2b3ef25
https://thoughtbot.com/blog/can-auto-playing-videos-be-accessible
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HTML Accessibility 

Introduction 
This guide explains how to create accessible content using common HTML building 
blocks: headings, lists, regions, checkboxes and radio buttons groups, buttons, links, 
inputs, labels, error messages, and alerts. It is written for people who use a content 
management system and do not write code directly. 

Accessible HTML content supports people who use assistive technologies such as 
screen readers and keyboard navigation. It also supports people with visual, motor, 
cognitive, and language disabilities. The guidance in this document complies with the 
Americans with Disabilities Act Title II, the European Accessibility Act, and Web Content 
Accessibility Guidelines 2.2 Level A and Level AA. 

As a content creator, you are responsible for choosing the correct content types in your 
editor, writing clear text, and organizing information logically. You do not need to edit 
HTML code, but you should select the right options such as heading styles, list tools, 
and form labels in your content management system. 

Requirements 
Create content with clear structure, relationships, and purpose.  

Headings 
Headings outline the content of a web page both visually and structurally. They help 
people understand and navigate content. 

What you should do 
- Use the main heading style once per page for the page or article title. 

- Apply heading styles in logical order. Do not skip levels. For example, do not 
jump from a top-level heading directly to a much lower level. 

- Make every heading describe the content that follows in clear and simple 
language. 

- Use heading styles only for real section titles, not to make text larger or bold. 
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What you could do 
- Keep headings short and easy to scan, such as "Program overview" instead of a 

long sentence. 

- Break long pages into smaller sections using headings to prevent large blocks of 
text. 

- Use a heading outline tool to review the order and nesting of headings. 

Concrete examples 
- Good: Page title "Undergraduate admission" as the main heading with section 

headings such as "Admission requirements" and "How to apply". 

- Not good: A paragraph of body text styled visually as a heading to change its 
appearance. 

Lists 
Lists help people understand groups of related items and how many items are in the 
group. 

What you should do 
- Use the bulleted list tool for groups of items where order does not matter, such 

as features or topics. 

- Use the numbered list tool for steps or instructions where order matters. 

- Use the list button in your editor. Do not type bullets or numbers by hand. 

What you could do 
- Keep each list item focused on one main idea. 

- Group long lists under subheadings to avoid overwhelming users. 

Concrete examples 
- Good: "Steps to apply" followed by a numbered list of actions in order. 

- Not good: A paragraph converted into a bulleted list only for visual style without 
clear list meaning. 
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Checkbox and radio button groups 
Checkboxes allow users to select one or more options from a list. Radio buttons allow 
users to select only one option from a set. These controls are usually grouped visually. It 
is important to reflect that grouping in the code as well. 

What you should do 
- Provide a clear question or statement before each group of checkboxes or radio 

buttons, such as "Select your preferred contact method". 

- Make each option label clear and meaningful on its own, such as "Email" or 
"Phone call". 

- Keep all options that belong to one question together. Do not split them into 
separate groups. 

What you could do 
- Add short help text if users may not know whether they can select one or many 

options. 

- Limit the number of options or organize long lists into categories to reduce 
cognitive effort. 

- Use simple, plain language so that options are easy to understand and translate. 

Concrete examples 
- Good: "Choose your newsletter topics" with checkboxes for "Research updates", 

"Events", and "Training". 

- Not good: A set of checkboxes with no question and unclear labels so users have 
to guess what to do with them or if they are even related. 

Buttons and links 
Buttons trigger actions and events on a page such as submitting a form, saving 
changes, or starting a search. Links move users to another page, part of the current 
page, a document, or an external site. Using the right element to create the correct 
event is critical in helping all users make sense of the information you are presenting to 
them. 

What you should do 
- Use buttons for actions that change something on the current page or send 

information, such as "Submit form", "Save changes", or "Search". 
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- Use links for navigation to other pages, documents, or sites. 

- Write button labels that clearly describe the action triggered when people press 
it, so that they know what will happen ahead of time. 

- Write link text that clearly describes its destination. 

- Make link text meaningful when read alone. Some users navigate using a list of 
links. 

- Ensure links are visually recognizable as links, not only by color. Use the styles 
provided by your editor. 

What you could do 
- Place main buttons in consistent locations such as after a form or at the end of 

the main content for that task. 

- Use short, action-focused labels such as "Create account" instead of long 
phrases. 

- Work with design to ensure that buttons are clearly recognizable and not 
confused with plain text or images. 

- Put key words at the start of link text, such as "Course schedule" instead of 
"Click here for the course schedule". 

- Keep link text short. Avoid turning whole sentences into one long link. 

- Group related links in lists under headings such as "Further reading" or "Related 
documents". 

Concrete examples 
- Good button: "Send message" button placed directly after a contact form. 

- Not good button: An image or icon with no text that users must activate to submit 
a form. 

- Good link: "View course schedule" as the link text that goes to the schedule 
page. 

- Not good link: Many "Read more" or "Click here" links on the same page without 
extra context. 
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Inputs and labels 
Inputs include text fields, number fields, date fields, and text areas where users enter 
information. These are the most common input types in content management systems. 

Labels are the visible text that tells users what information belongs in each input. 
Labels should be close to the field or control they are labeling so that users can easily 
see which label goes with which input. 

What you should do 
- Provide a clear label for every input so that users know what information to enter, 

for example "First name" or "Email address". 

- Place labels close to their inputs, either directly above or next to the field. 

- Make label text unique, clear, and descriptive, especially when the page has 
many fields. 

- Indicate required fields in the label or nearby text, for example by using the word 
"Required" or a symbol that is explained. 

- Avoid relying only on placeholder text inside an input as the label, because it 
disappears when users start typing. 

What you could do 
- Provide short instructions before groups of inputs to explain what users will need 

and how long it might take. 

- Use simple and consistent label wording across forms, such as always using 
"Phone number" instead of changing terms. 

Concrete examples 
- Good: A form with labels "First name", "Last name", "Email address", and "Phone 

number" shown next to or above each input, with "Required" indicated where 
needed. 

- Not good: Inputs that show only placeholder examples such as "Type here" and 
no visible labels. 

Error messages and alerts 
Error messages tell users when something goes wrong with their input or when they 
need to fix information before continuing. Alerts notify users about important 
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information or changes that need their attention. These messages can appear in 
different forms such as text near a field, dialogs, or pop-ups. 

What you should do 
- Place error messages close to the field they are providing feedback for, so users 

can quickly identify and fix the problem. 

- Write error messages that clearly explain what went wrong and how to fix it, for 
example "Email address is required" or "Phone number must include area code". 

- Make error messages meaningful and specific. 

- Ensure that if an alert contains actionable content such as buttons, keyboard 
focus transfers to that content when the alert appears. 

- Check with your accessibility team or content management system vendor if 
keyboard focus does not move automatically to actionable alerts. If this is not 
possible in your system, avoid using that pattern. 

What you could do 
- Use consistent error message wording across your site, so users learn to 

recognize and understand them quickly. 

- Provide a summary of all errors at the top of a form when multiple fields have 
problems, with links to each error. 

- Test alerts and error messages by navigating with only a keyboard to confirm that 
focus moves correctly. 

Concrete examples 
- Good: An error message "Email address is required" appears directly below the 

email input field when the user tries to submit without completing it. 

- Not good: A pop-up alert with a "Close" button appears but keyboard focus 
remains on the form behind it, making it difficult for keyboard users to interact 
with the alert. 
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Quick reference table 

Area Should do example Could do example 

Headings 
Use one main heading per page and 
keep heading levels in logical order. 

Keep headings short and front-
load key words. 

Lists 
Use the list button in your editor for 
groups of items. 

Keep each list item focused on 
one main idea. 

Regions 
Use headings to mark sections and 
keep each section focused on one 
purpose. 

Label side content clearly such as 
"Related links" or "Further 
reading". 

Checkbox 
and radio 
groups 

Provide a clear question before 
each group and make each option 
label clear and meaningful. 

Add short help text if users may 
not know whether they can select 
one or many options. 

Buttons 
Use buttons for actions and write 
button labels that clearly describe 
the action. 

Place main buttons in consistent 
locations and use short action-
focused labels. 

Links 
Write link text that clearly describes 
the destination and make link text 
meaningful when read alone. 

Put key words at the start of link 
text and group related links in lists 
under headings. 

Inputs 
and 
labels 

Provide a clear label for every input 
and place labels close to their 
inputs. 

Provide short instructions before 
groups of inputs and use simple, 
consistent label wording. 

Error 
messages 
and alerts 

Place error messages near the field 
they relate to and write messages 
that explain what went wrong and 
how to fix it. 

Use consistent error message 
wording and provide a summary 
of all errors at the top of a form 
when multiple fields have 
problems. 
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Resources 
Use these resources to learn more on how to review the accessibility of your content.  

- W3C Easy Checks: A simple guide for quick checks such as headings, link text, 
and form field labels. Use it when you want to do a fast, non-technical review of 
your pages. 

- W3C Writing for Web Accessibility: Tips on writing clear headings, link text, and 
instructions. Use it when you want to improve the language of your content. 

- The A11Y Project Checklist: A checklist written in plain language that covers 
forms, labels, headings, links, and other topics. Use it when planning or 
reviewing content to confirm that your pages meet accessibility expectations. 

 

https://www.w3.org/WAI/test-evaluate/preliminary/
https://www.w3.org/WAI/tips/writing/
https://www.a11yproject.com/checklist/
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Visio flowchart and diagram accessibility 
This is a guide to Visio diagram accessibility with links to key resources.  

Microsoft provides comprehensive guidelines which should be consulted in the first 
instance: Make Your Visio Diagram Accessible to People with Disabilities.  

Accessibility Checker 
The built-in Microsoft Accessibility Checker quickly checks a Visio diagram and 
presents a list of actions to make it accessible. 

Find the Accessibility Checker in the Review tab and select ‘Check Accessibility’. 

In the Accessibility Checker results box that appears, you can also tick the box to keep 
the checker running while you work on a document, which places an accessibility 
status in the footer of the document. 

Run the checker tool before completing a document to verify many of the points below. 

Key resource: Microsoft – Check your diagram with the Accessibility Checker. 

Using a template 
Visio has a set of templates that include default accessibility features, such as the 
navigation order, which can greatly reduce adjustments later in production. It is 
possible to remove, add, and change shapes and connectors within the template. 

Key resources: 

- Microsoft: Create a diagram from a template. 

- Microsoft: featured Visio templates and diagrams. 

Establishing the reading order 
A screen reader or keyboard user will use the Tab key to navigate through the shapes in a 
Visio diagram. It is therefore important that the reading order of the shapes is correct for 
a meaningful user experience. 

The reading order is generally set by the order in which the shapes were added to the 
diagram. However, you can edit the order in the Diagram Navigation pane: View > Task 
Panes > Navigation. Drag and drop the shapes into the desired reading order. 

Key resources: 

https://support.microsoft.com/en-gb/office/make-your-visio-diagram-accessible-to-people-with-disabilities-e2c847a9-f010-4fef-af65-16e252829d44
https://support.microsoft.com/en-gb/office/make-your-visio-diagram-accessible-to-people-with-disabilities-e2c847a9-f010-4fef-af65-16e252829d44#bkmk_acwin
https://support.microsoft.com/en-gb/office/video-create-a-diagram-from-a-template-453ca3a8-3ae8-437b-88c7-38cd44e55d28
https://support.microsoft.com/en-gb/office/featured-visio-templates-and-diagrams-27d4274b-5fc2-4f5c-8190-35ff1db34aa5
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- Microsoft: Adjust the reading order. 

- Microsoft: Use a screen reader to read Visio diagrams 

Alt text for diagrams, visuals, master shapes and pages 
Visio diagrams and flowcharts are complex images that communicate information 
visually. Adding alt text to all relevant elements and stages in your diagram ensures that 
everyone can engage with it; for example, people using read aloud software to 
understand the purpose of shapes, images and entire pages. 

The Web Content Accessibility Guidelines (WCAG) requirements for images  

Shapes, images, and master shapes:  

- Right-click the shape or image, select Format Shape, then go to the Size & 
Properties tab (the icon with four arrows pointing outwards).  

- In the Alt Text section, provide both a title and a description that briefly but 
informatively describes the element's content or function in the flowchart.  

- If your image is purely decorative, state this as the alt text. 

Pages:  

- Add alt text to a page so that screen reader users receive a high-level summary of 
the page.  

- For each page, press Shift+F5 or right-click the page tab, select Alt Text, and type 
a title and description that summarises the page's content or purpose. 

The alt text in question should conform to existing Elsevier alt text guidelines, 
particularly highlighting where visual elements such as shapes, arrows and use of 
colour indicate a differentiation or a decision. 

Key resources:  

- W3C – Complex images.  

- Microsoft – Add alt text to diagrams, visuals, master shapes, and pages. 

Use of colour 
Text colour contrast: Aim for a minimum of 4.5 to1 text to background contrast ratio to 
meet the WCAG 1.4.3 Contrast criterion. 

https://support.microsoft.com/en-gb/office/make-your-visio-diagram-accessible-to-people-with-disabilities-e2c847a9-f010-4fef-af65-16e252829d44#bkmk_readingorderwin
https://support.microsoft.com/en-gb/office/use-a-screen-reader-to-read-visio-diagrams-45ff89fc-fcd8-4c99-bc21-70eb9af29a61
https://www.w3.org/WAI/tutorials/images/complex/
https://support.microsoft.com/en-gb/office/make-your-visio-diagram-accessible-to-people-with-disabilities-e2c847a9-f010-4fef-af65-16e252829d44#bkmk_alttexttoallwin
https://aaardvarkaccessibility.com/wcag-plain-english/1-4-3-contrast-minimum/
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Non-text colour contrast: Ensure a minimum 3 to 1 contrast ratio between adjacent 
elements, such as a coloured box placed over a box of another colour. See WCAG 
1.4.11 Non-text Contrast. 

Background images: Avoid placing busy or complex images behind text.  Where a 
background image is used, add an outline around the text that results in a 4.5 to 1 text to 
background contrast. 

Use of colour: Do not use colour alone to distinguish. Consider the use of shades, lines, 
patterns (sparingly), text labels, and symbols. 

Key resources:  

- Colour Contrast Analyzer 

- WebAim Contrast Checker 

Font choice and font size 
Choose clear fonts for readability, such as Arial, Aptos or Calibri.  

Use a minimum font size of 18pt, with larger font size for headings. 

Avoid all capital letters, excessive italics, or underlining.  

Use built-in list styles to structure information and make lists easily navigable. 

Create white space around the text for a readable experience, using Paragraph Spacing. 

Informative links 
Avoid adding full hyperlink threads. Instead, display meaningful text that clearly 
communicates what the user will find when they select it. For example, Elsevier 
Accessibility homepage. 

Avoid generic link text such as ‘Click here’ or ‘Learn more’. Screen reader users have the 
ability to select from a list of all the links in a document, and unique, clear links are 
quickly identifiable. 

Key resource: Microsoft: Add or remove a hyperlink in a Visio drawing. 

Exporting to an accessible PDF 
When saving your flowchart for wider distribution, you can convert it to an accessible PDF:  

1. In Visio, select File > Save As and choose PDF as the file type. 

2. Select the Options button in the Save As dialog box. 

https://www.w3.org/WAI/WCAG22/Understanding/non-text-contrast
https://www.w3.org/WAI/WCAG22/Understanding/non-text-contrast
https://www.tpgi.com/color-contrast-checker/
https://webaim.org/resources/contrastchecker/
https://www.elsevier.com/about/accessibility
https://www.elsevier.com/about/accessibility
https://support.microsoft.com/en-gb/office/add-or-remove-a-hyperlink-in-a-visio-drawing-271fb2a8-4081-47db-a333-487315c05085#OfficeVersion=Desktop_app
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3. Ensure the Document structure tags for accessibility checkbox is selected, 
then select OK and Save. This adds the necessary accessibility tags that screen 
readers need to interpret the file's structure.  

Finally, test the accessibility using a screen reader such as Windows Narrator to 
experience the diagram as an assistive technology user would.  
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